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Summary 
 
RRS James Clark Ross trials cruise JRtri006 took place from 27th June 2011 to 3rd July 2011. The EM122 
multibeam acceptance trials began in Portsmouth and following a brief boat transfer at Falmouth 
proceeded to the Porcupine Basin and then north to the Hebrides Terrace seamount, west of Scotland. 
Following calibration tests, the cruise ended at Glasgow. A cruise track is shown in Figure 1. Weather and 
sea state was generally calm during the first few days with a strengthening southerly wind and increased 
swell towards the latter part of the cruise. All essential calibrations and trials were undertaken as well as 
many of the secondary objectives. 

 
Objectives  
 
The main objective of the cruise was to accept the installation of the Kongsberg EM122 multibeam 
upgrade. This upgrade replaced an EM120 which was installed during refit in 2000. As well as the 
commissioning report from the Kongsberg installation engineer (see Appendix A), the trials consisted of 
roll, pitch and heading calibrations plus tests to look at noise levels, data quality and integration with other 
acoustic instruments through the Simrad Synchronisation Unit (SSU). The Seatex Seapath (GPS and motion 
reference sensor) was also upgraded during refit to a 320+ model (replacing the Seapath 200). As the 
Seapath 320+ provides both position and motion data to the EM122, there is a brief discussion in this 
report about user configurations within the Seapath software. 
 
A secondary focus was user training on the Kongsberg Seafloor Information System (SIS) acquisition 
software. This Microsoft Windows 7 based software replaced the Kongsberg Merlin acquisition software 
running on Sun Solaris. While the new software has much of the same functionality as Merlin, it has several 
new features that will be highly useful for survey work. An outcome of the cruise was to update the ‘How 
to’ document for scientific users who want to use the EM122 for opportunistic surveys (see Appendix B). 
 
Several routines involving data transfer to and from the EM122 acquisition machine had to be changed 
after the upgrade including importing sound velocity profiles from XBTs and CTDs, raw data backup onto 
the SAN and outputting EM122 centre beam depth to the Shipboard Computer System (SCS). 
 
Depth, backscatter and water column data logged by the EM122 were inspected in a variety of different 
post-processing packages to assess quality and to compare to archival EM120 data collected during cruise 
JR130 (multibeam training cruise, 2005). 
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Narrative 

26th June 2011, Sunday, Jday 177 
The scientific party arrived at Portsmouth at 1400. 
 
27th June 2011, Monday, Jday 178 
Setup tasks whilst the ship was still in dock. The Kongsberg engineer gave training on the Seatex Seapath 
320 followed by user training on the principles of multibeam data collection and the SIS acquisition 
software for five of the scientific party. A problem with the SSU not correctly receiving EM122 signals was 
identified. 
 
28th June 2011, Tuesday, Jday 179 
Following an emergency muster drill the ship departed Portsmouth at 1100, heading into the Channel for 
engine and dynamic positioning trials. The SSU problem was solved (see Appendix A) and SIS user training 
continued for the first group. There was an overnight passage to Falmouth. 
 
29th June 2011, Wednesday, Jday 180 
Engine testing continued whilst the ship stooged close to Falmouth. Contractors and ETS support (Richard 
Bridgeman) were transferred to Falmouth by small boat at 1400.  The ship proceeded towards a waypoint 
within the Porcupine Basin in order to test the EM122 in a range of depths and to test ping modes with 
respect to backscatter data quality. EM122 and SIS user training began for the second group from the 
scientific party.  
 
30th June 2011, Thursday, Jday 181 
Individual three hour watches were assigned for users to play with the SIS software. Ping mode testing was 
carried out as the ship travelled across the continental shelf into deeper water in order to determine 
effects on backscatter data. This was followed by noise tests at a variety of different speeds. Similar noise 
tests were also carried out with other acoustic instruments turned on while maintaining a constant speed. 
A brief trial synchronising multiple acoustic instruments was undertaken to compare with findings from the 
acoustic setup trials cruise in June 2008. 
 
1st July 2011, Friday, Jday 182 
EM122 watches continued through the day as the ship sailed north towards the roll calibration site in the 
Rockall Trough. Weather was mainly overcast with sea state worsening from 4/5 to 6/7 throughout the 
day. Roll calibration started at 2000 and continued for several hours. Line directions were 035/215 degrees 
in order to minimise poor data collection due to sea state and crabbing. 
 
2nd July 2011, Saturday, Jday 183 
The ship transited from the roll calibration site to the Hebrides Terrace seamount for the pitch and heading 
calibrations. These were completed on the south west slopes of the seamount but there was insufficient 
time to repeat lines collected on JR130 on the northern slopes. A three line survey was completed to the 
south of the seamount in order to compare overlapping swaths. This was completed with a cross track 
though the middle. Finally a second roll calibration was performed before trials ended at 1400. On the 
passage to Glasgow, EM122 data was recorded up to the continental shelf at around 1700. 
 
3rd July 2011, Sunday, Jday 184 
The ship continued passage to Glasgow, docking at 1400. 
 
4th July 2011, Monday, Jday 185 
The scientific party depart the ship at 0800. 
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Personnel 
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ELLIOTT, Thomas R W  2nd Engineer 
STEVENSON, James S  3rd Engineer 
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Figure 1 shows the JRtri006 cruise track. A = Ping mode tests. B = Noise tests in Porcupine Basin, C = Roll 
Calibration, Rockall Trough. D = Pitch and heading calibrations, Hebrides Terrace seamount. E = 3x1 overlap 
test with second roll calibration. 
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Equipment Reports 
 
EM122 multibeam echo-sounder calibration report (Alastair Graham) 
 
1. Introduction  
 

A main aim of the trials cruise was to calibrate the EM122 system and its external sensors to ensure 
reliability and accuracy in depth measurements. Calibration should improve data quality by correcting for 
offsets in measurement of the pitch, heading and roll of the ship, as well as latency between sensors.  

Before the cruise, the sensors (transducer and receiver arrays, and inertial sensor) on JCR were 
surveyed with respect to the vessel’s reference plane, and installation angles established. The procedure 
for calibrating the EM122 involves running a series of trial lines of specific configuration, normally with 
overlapping swaths, from which additional biases in installation angles or time synchronisation can be 
established. Biases can stem from misalignments in the transducers or MRU, or from time synchronisation 
differences between the different sensors. Any offsets can be measured and applied to the attitude sensor 
(the MRU) via the SIS software. 
 
The first calibration of the new EM122 system was performed on cruise JRtri006. This report provides: 

1. A basic step-by-step guide for calibration of the multibeam system.  
2. Description and results of the JRtri006 calibration surveys. 
3. Recommendations for future operation. 

 
2. Brief step-by-step procedure for EM122 calibration 
 
Use the SIS software Operator manual as a full guide to performing an EM122 calibration. See p. 158 and 
onwards for details.   
 
1. Choose a suitable location for your calibration survey. Ideally, this should be partly steep although not 
too steep to compromise data quality, and include areas of flat, featureless topography. 
2. Take an XBT or CTD to obtain a decent sound-velocity profile in the working area. 
3. Apply the SVP to your survey. 
 
4. Roll calibration: roll is often the largest offset so correct for this first. 

a. preferably in >2000 metres but can be shallower; preferably flat sea-floor 
b. run two reciprocal lines with 200% overlap, at least two times the length of the swath width 

(normally 8-10 km) at constant vessel speed (4-6 knots).  
c. establish offsets of lines in the SIS Calibration window taking several corridors across (at 90 

degrees to) the survey lines (see user guide for details); roll error will appear as depth 
differences increasing across-track away from the centre (Fig. 2).  

d. Input the corrections to the Installation Parameters window of the SIS software. For all 
calibration corrections, the first two sets of offsets shown in this window were provided by the 
surveyors during installation and should not be changed. The “Attitude 1” row relates to the 
MRU 5+ angles in the SIS software and offsets should be inserted here only. 
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Figure 2. Cartoon showing across-track example of roll error between two lines. 

 
5. Pitch calibration:  

a. 2000-6000 m, preferably up and down a slope or across a feature 
b. run two reciprocal lines with 200% overlap, at least two times the length of the swath width, 

directly up and down the slope in opposite directions. 
c. establish offsets of lines in the SIS Calibration window taking a corridor along-track (parallel) to 

the survey lines; as long as there are no time delay or positioning errors, pitch error will 
appear, on a constant gradient slope, as a depth offset between the lines increasing with depth 
(Fig. 3). 

d. Input the corrections to the Installation Parameters window of the SIS software. 
 

 

 

Figure 3. Cartoon showing example of expected Pitch error between two lines. 

 
6. Heading calibration: 

a. Find a recognisable feature such as a peak or depression 
b. Survey two lines in the same direction, at opposite sides of the feature so that the feature lies 

in the outer beams of both swath tracks (Fig. 4). 
c. compare the offset between the two lines in the Calibration window, taking a corridor along-

track through the feature: a heading error will show the feature on one line ahead of/behind 
the feature on the reciprocal. Adjust offsets to bring the feature on the two tracks together. 

d. Input the corrections to the Installation Parameters window of the SIS software. 
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Figure 4. Example of heading error between two overlapping swath lines 
 
7. Finally, carry out a second Roll calibration as a final check. Input offsets as an additive to the first set of 
corrections, if needed.  
 
3. JRtri006 calibration narrative and results 
 
Calibration of the EM122 was conducted south of the Hebrides Terrace Seamount on the floor of the 
Rockall Trough between the 1st and 2nd July 2011. A new survey JRtr006_C was started for the calibration 
tests. Prior to logging, T5_0007.asvp was applied from an XBT cast. The SVP was spiky and noisy in the top 
800 metres, but otherwise sensible.  
 
Line 0 (zero) was a test line.. Line 1 logged the first of the calibration tracks for measuring Roll error. Survey 
speed was 4 knots, and the Doppler was switched off before logging which reduced water column 
interference significantly. ‘Horns’ in the data were not as apparent as in previous data. However, 25 knot 
winds gave a strong swell and the edges of the data were degraded. The central part of the swath looked 
flat and suitable for calibration. We obtained a 7 km line heading NNE-SSW.   
 
Line 2 logged the reciprocal, SSW-NNE. The line initially veered away from the track (~300 m), but there 
was good overlap in the second half of the line. Strong winds meant we were forced to crab up the line to 
stay on-track. Data quality was poor.  
 
We carried out a roll calibration on the two lines (Figs 5-7). Corridors were taken at numerous intervals 
across the calibration tracks. A roll offset of +0.15° was measured. A cross-check with the Auto-calibration 
function of SIS gave a predicted offset of +0.066°. Visual inspection suggested this was probably an 
underestimate, because the Autocalib tool took account of poor data in the outer beams that we had 
largely ignored. The offset of +0.15° was applied in the Installation Parameters of the SIS software under 
the “Attitude 1” section. 
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Figure 5. Roll calibration tracks 

 

 

Figure 6. Across-track corridor from first roll calibration with zero correction applied. 

 

Figure 7. Across-track corridor from first roll calibration with +0.15 offset applied. 

+0.15° 

No correction 
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Lines 3 through 7 logged our passage overnight to the flank of the Hebrides Terrace Seamount.  
 
Line 8 logged the first line up the seamount slope for a Pitch calibration. The line was surveyed with a NE 
heading at 6 knots (pilot could not hold course at 4 knots). Recognisable features were seen on the upper 
flank of the seamount. Data quality were good, except for in the outer beams.  Line 9 logged the reciprocal 
for Pitch calibration.  
 
We carried out a Pitch calibration on the two lines. A corridor was taken along the two tracks. The two 
profiles showed an excellent match. No error was measured (Fig. 8).  
 

 

 

Figure 8. Along-track corridor showing calibration window with zero correction between tracks. 

 

Two additional tracks were acquired around the Pitch calibration lines to carry out a Heading calibration. 
Line 10 logged a track to the west of our Pitch calibration lines, heading NE at 6 knots. Line 11 logged a 
parallel line to the east of the Pitch calibration lines, ensuring a 100% overlap.  
 
We ran a Heading calibration on the two lines together with the lines acquired for Pitch calibration in the 
previous test. A corridor was taken along the centre track. Low signal-noise ratios in the outer beams 
prevented depth measurements in the outer sectors from being of any use in the calibration. Instead, we 

No correction 
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focused on the central parts of the swath where data quality was notably better. We measured a heading 
error of –0.6°. (Figs 9-11).   
 

  

Figure 9.  Along-track corridor showing Heading calibration lines, no correction. 
 

 

Figure 10. Along-track corridor showing Heading calibration lines with -0.6° correction. 

No correction 

-0.6° 
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Figure 11. Tracks used for the Heading calibration. 

 
On completion of the Heading calibration, we transited 11 nm to the SE to survey a 3 x 1-line swath grid to 
verify our calibration corrections. The grid survey involved collecting three parallel lines, each c. 7-8 km 
long with 100% overlap, tied together by one cross line of a similar length. A new survey was setup for the 
grid survey (JRtri006_D) and a new SVP (T5_0008.asvp), obtained from an XBT cast, was applied to the 
system prior to logging. The EM122’s dual mode was also changed from a fixed setting to a dynamic setting 
for the survey. Strong winds on the beam during survey meant the ship had to crab along the lines, 
reducing the data quality.  
 
Line 0 (zero), Line 1, and Line 2 logged the three parallel grid lines in a NNW-SSE orientation, at 6 knots. The 
cross line was logged to Lines 3 and 4, also at 6 knots. Engineers at Kongsberg will provide more 
information on data quality during post-cruise analysis of the grid. 
 
A final roll calibration was conducted in order to verify that the roll corrections initially applied to the 
system were valid. Line 5 was surveyed back along the cross line of the grid survey (approximately ENE-
WSW). Line 6 also collected data back across the original track of Line 0. From the latter we measured an 
additional Roll correction of +0.02°, bringing the total summed Roll correction for the trials to +0.17°.  
 

4. Results of the EM122 calibration in summary 
 
N.B. All corrections are additive. The Attitude sensor corrections at the start of the cruise all read at zero. 
The following corrections were applied to the system in SIS software, under the “Attitude 1” row of the 
Installation Parameters > Sensor setup > Angular offsets: 
 

Calibration Correction 
 

Roll 1:  +0.15° 
Pitch:  0 (zero)° 
Heading: -0.6° 

 Roll 2 (check): +0.02°  

 Total Roll: +0.17° 
 

5. Problems and recommendations     
 

• The outer beams on the EM122 have high noise levels (low signal-noise ratios), making calibration, 
using data from the outer sectors of the swath particularly difficult. 

• Calibration of the sensors should be performed at the beginning of every dedicated multibeam 
survey. As a minimum, a roll check should be carried out before any cruise which involves 
substantial multibeam data acquisition.  
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• If no geophysics cruises are scheduled, calibration should still be performed at least once per year 
and certainly after any modifications to the sensors (e.g. during refit).  

 

• Areas should be identified near to operational bases and ports where calibration of the EM122 can 
be conducted and repeated at regular intervals. 

 

• It is better to perform a calibration than not! 
 

6. Obtaining parameters used for an EM122 bathymetry line (from the JCR wiki: Multibeam 
calibration). 

On the Neptune machine, use the following commands: 

printDatagrams -f <surveyline>_raw.all -d # 
 
where # is  
i : installation parameters; R : runtime parameters; P : positions; D : depths 

7. Lines recorded during calibration 

Survey JRtr006_C 
0000_20110701_191505_JCR.all Test line 
0001_20110701_193714_JCR.all Roll Calibration 1 
0002_20110701_203159_JCR.all Roll Calibration 2 
0003_20110701_213830_JCR.all Transit to Hebrides Terrace Seamount 
0004_20110701_223831_JCR.all Transit to Hebrides Terrace Seamount 
0005_20110701_233828_JCR.all Transit to Hebrides Terrace Seamount 
0006_20110702_003828_JCR.all Transit to Hebrides Terrace Seamount 
0007_20110702_013827_JCR.all Transit to Hebrides Terrace Seamount 
0008_20110702_020214_JCR.all Pitch Calibration 1 
0009_20110702_030047_JCR.all Pitch Calibration 2 
0010_20110702_035357_JCR.all Heading Calibration 1 
0011_20110702_051552_JCR.all Heading Calibration 2 
0012_20110702_061646_JCR.all Transit to SE 
 

Survey JRtri006_D 
0000_20110702_074558_JCR.all Grid survey, Line 1 
0001_20110702_085955_JCR.all Grid survey, Line 2 
0002_20110702_100231_JCR.all Grid survey, Line 3 
0003_20110702_110042_JCR.all Grid survey, Cross-line 
0004_20110702_120037_JCR.all Grid survey, Cross-line 
0005_20110702_122354_JCR.all Roll Calibration check 1 
0006_20110702_123829_JCR.all Roll Calibration check 2 
0007_20110702_135009_JCR.all Transit lines towards Clyde 
0008_20110702_145008_JCR.all Transit lines towards Clyde 
0009_20110702_151355_JCR.all Transit lines towards Clyde 
0010_20110702_161352_JCR.all Transit lines towards Clyde 
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EM122 Data Quality Testing (Christine Bachelor and Kelly Hogan) 
 
One of the major goals of the JRtri006 Trials Acceptance cruise was to assess the quality of multibeam 
bathymetry data obtained from the newly upgraded EM122 system.  Although the initial aims of the cruise 
included a comparison of EM122 data with an EM120 dataset collected during the JR133 cruise of 2005, a 
combination of time constraints and poor EM120 data quality precluded direct comparison of these data.  
Whereas the JR133 instrument calibration tests took place on the northern slope of the Hebrides Terrace 
Seamount, JRtri006 cruise calibration was performed on the southern slope of the seamount - a more ideal 
location due to its steeper slope.   
 
Knowledge of the EM120 system from previous cruises has enabled categorisation of a number of 
systematic and non-systematic errors that have been observed in swath bathymetric datasets acquired on 
the JCR.  Systematic errors included the presence of ‘wobbles’ in the outer beams, horn-like ridges either 
side of the central beams (more prevalent in shallow water depths), offsets in bathymetry between 
adjacent lines (non-SVP errors), and beam penetration of the seafloor.  Non-systematic errors include SVP-
related errors, ping dropouts, excessive noise in the outer beams, and noisy data due to poor weather 
conditions (beam-on).  The presence/absence and magnitude of these error types in the bathymetry data 
collected by the EM122 system was assessed throughout JRtri006.  
 

Systematic Errors 
 
Wobble Errors 
A distinctive ‘wobble’ artefact (common in EM120 datasets) was again identified from the outer beams of 
the JRtri006 EM122 data (Figure 12).  The signal to noise ratio (SNR) is typically lower in the outer beams 
than in the central beams due to higher levels of interference occurring at the lower frequencies of the 
outer beams.  This interference leads to degradation of the transmitted (and thus returned signal) in the 
outer sectors of the swath. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 12: Example of pervasive wobble artefact in JRtri006 bathymetry data. Below is a cross-profile across 
the data showing the periodicity of the wobble error; profile is located on the swath data (light blue) and 
runs from west to east. 
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Figure 13: CARIS screengrab from a line of the JRtri006 EM122 data, showing the standard deviation of 
the beam errors.  The lines shown are the same lines as in Fig. 12. The systematic wobble error is clearly 
shown in the outer beams. 
 
Although errors due to interference are more frequently observed in the outer beams, a problem that is 
exacerbated by poor weather and sea conditions, the wobble effect identified on EM120 and EM122 
datasets (Figs. 12 and 13) is a more systematic error.  As an example, the wobbles observed on the JRtri006 
lines in Figure 1 possess amplitudes of 5-10 m and a periodicity of 15-200 m (Fig. 12, cross profile).  The 
standard deviation of the errors is shown in Fig. 13; the systematic wobble error is clearly apparent on the 
outer beams.  

 
The wobble artefact may be caused by low source levels resulting from degradation of the central 
transmitter elements.  Improved source levels may prevent the development of these outer beam errors.  
Analyses of the transmitter elements on the EM122 system carried out by a Kongsberg engineer prior to 
the start of JRtri006 revealed widespread degradation of the central transmitter elements (c. 40% elements 
were found to be degraded).  The substandard characteristics of the central transmitter elements could be 
reduced by checking the hull for any damage including biological growths, silt between the titanium covers 
and the transducers or by replacing the transducers. Additional analyses of the JCR EM122 data with 
respect to transducer element problems will be carried out by Kongsberg on data collected during JRtri006. 
 
Swath Sector Errors 
Systematic errors associated with the different sectors of the EM122 swath occur in two forms: first, as a 
distinct line marking the boundary of the outer sector (Figure 14); and second as variable bathymetry 
returns between different sectors forming ‘mounds’ at sector boundaries (Figure 15a). 
  



[18] 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 14: CARIS screengrab of a line from JRtri006 showing the outer sector line error (arrowed); outer 
beam wobbles are also apparent. The finer parallel along-track lines in the outer sector are gridding errors 
(data was gridded at a higher resolution than appropriate to show the errors). 

 
Swath sector errors are also apparent when the individual pings of a line are viewed in MBedit (Fig. 15b).  
Mounds exist in groups of 2 pings and occur approximately every 4 - 12 pings.  The reason for the 
occurrence of these mounds in groups of 2 pings is not well known but may be related to the dual ping 
mode used during data acquisition. This systematic error type was particularly evident in the EM122 data 
during lines 0024 and 0025 on 01/07/2011 during poor weather conditions.  A heading of 0.003 – 0.004 
degrees was recorded during data collection, with a wind from the south at 19 knots, and swell off at 45 
degrees.  Pitch, roll and heave values were recorded as 0.8°, 2° and 1°, respectively.  Degradation of JCR 
swath bathymetry data quality is well known when weather conditions include wave or swell conditions 
that are beam-on and this is what caused the decrease in data quality on 01/07/2011. 

 
The swath sector errors appear to be particularly pervasive in the EM122 swath data. The errors are 
possibly related to the transition from the central to the outer beam sectors and the corresponding change 
in frequency across this boundary (Kongsberg report forthcoming).     

 
Horn Errors 
Horn-shaped ridges have been observed to occur either side of the nadir in EM120 datasets from the JCR.  
This type of systematic error was widespread on EM120 datasets, particularly in shallow (continental shelf) 
water depths, but has not been identified from the JRtri006 cruise EM122 system data.  The positions of 
the horns corresponded with the across-track transitions from amplitude to phase bottom detection.  
Improvements in the electronics of the EM122 as compared to the EM120, and in the beam-forming 
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mathematics used by the EM122 mean that this error is much less likely to occur with this generation of 
echosounder.   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
Figure 15a: Screen dump showing the presence of outer sector mounds on line 0024 (01/07/2011) acquired 

using the EM122 system during the JRtri006 cruise.  Figure 15b: Individual pings from line 24 (VE 4.18) 
illustrating how the mounds occur in groups of two pings with a fairly regular periodicity. 

Mounds 

a 

b 
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Seafloor penetration 
Central ‘troughs’ running along the nadir have been identified from EM120 system data (Figure 16).  This 
artefact probably indicates those areas of the seafloor which are composed of extremely soft sediments 
and consequently do not provide a larger enough acoustic impedance difference with the overlying water 
column from which the acoustic signal can be reflected.  The beams instead penetrate the seafloor and are 
reflected from a harder sub-bottom horizon some distance below the seafloor.  The resulting depression 
occurs over the central section of the swath because the beam energy is most intense in this location.  
Seafloor penetration errors identified from Western Greenland have been observed to create central beam 
depressions up to 12 m deep and 300 m in width (Fig. 16, bottom). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 16: Screen dump illustrating central beam seafloor penetration from EM120 data collected off West 
Greenland. Bottom: A cross-profile across the central trough formed by seafloor penetration. 

 
Seafloor penetration was not observed on the JRtri006 cruise.  Options for avoiding this error on future 
cruises include reducing the maximum power of the system (Mammal Protection option in Runtime 
Parameters) so that less energy is transmitted in the outward pulse.  The SIS range-gate option (in the Filter 
and Gains tab in Runtime Parameters), which determines the depths at which the seafloor can be picked, 
could constrain the depth at which the seafloor is detected.   
 
Non-Systematic Errors 
 
SVP errors 
The application of inaccurate SVP profiles typically produces upward or downward ‘bending’ of the outer 
swath where errors due to the wrong sound velocity through water will result in the greatest error due to 
the slant-range.  These artefacts are easily detected on adjacent survey lines, where the application of 
inappropriate SVPs results in offsets in seafloor depths between lines.  Acquisition of multiple SVP profiles 

Seafloor penetration  
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(from XBT or CTD) during any survey when these errors are observed on the SIS display will minimise these 
errors and the amount of post-processing time required in order to correct these issues.  

 
Excessive Noise  
The EM120 and EM122 systems are both vulnerable to data distortion through noise.  Beams in the outer 
sectors are more vulnerable to noise distortions than the central beams due to higher levels of interference 
occurring at the outer beam frequencies.  Excessive noise in the outer beams typically manifests itself as 
abrupt and erroneous changes in seafloor depths (Figure 17) and occurs when the returned signal is 
tracking noise rather than the seafloor.   
 
The assessment of outer beam noise performed on the EM122 data from JRtri006 was purely qualitative. 
As with data collected with the EM120 system, ‘noise’ was evident in the EM122 data as poor swath 
returns and particularly affected beams produced by the outer sector.  Noise levels, and thus the number 
of poor seafloor returns, increased during periods with poor weather conditions (beam-on).  Given the 
improvements in data density with the EM122 system (i.e. total seafloor ensonification) it was hoped that 
the quality of noise in the outer part of the swath would improve with the upgraded EM122 system. 
However, poor returns from the outer sector, probably caused by degradation of transducer elements (see 
Wobble Error for explanation), meant that the proportion of poor pings owing to noise was difficult to 
assess.  This will be easier to analyse following the replacement of transducer elements. 
 

 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 17: individual pings and beams from a section of line 24 of the JRtri006 cruise EM122 system data, 
showing typical outer beam distortions resulting from poor weather conditions (VE. 2.05). 
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Beam angles 
The effect of different beam angles on data quality (particularly excessive noise in the outer beams) was 
not systematically tested during the JRtri006 cruise.  Cruises typically log data with beam angles between 
60° and 65°, reducing these values during poor weather conditions.  During JRtri006 a range of beam angles 
were used spanning the range 50°-70° and reducing the beam angles during poor weather did result in a 
cleaner dataset as poor returns in the outermost beams due to random noise was reduced. However, 
decreasing the beam angles does not reduce the effects of systematic errors (wobble or outer sector 
errors), which were still evident in the JRtri006 data at all beam angles.  
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EM122 Noise Testing (Christine Bachelor) 
 
An assessment of the noise generated by the JCR was performed through a series of noise tests at ship 
speeds of 0, 1, 2, 4, 6, 8, 10, 12 and 14 knots.  In order to evaluate the influence of the different acoustic 
instruments, noise tests were also performed with the addition of the Doppler logger, the EK60, and the 
ADCP at speeds of 10 knots.  Weather conditions remained calm throughout the noise tests, with wind 
speeds of 5-6 knots.  Beam angles remained constant at 70°.  
 
Noise and JCR Speed 
Five noise tests were performed for both broadband noise and spectral noise at each ship speed.  Whereas 
the value for broadband noise represents the average measurement from one frequency over the modules 
during a given amount of time, spectral noise is the average from all the frequencies on the cards and 
characterises the acoustic signal being transmitted.  The average (median) broadband and spectral noises 
at different ship speeds are depicted in Figure 18. 
 
The results of the noise tests (Figure 18) clearly illustrate how broadband and spectral noise is greater in 
the outer boards, boards 1 and 4, than in the central boards.  This pattern is most evident at ship speeds of 
6-8 knots.  The results of the noise tests (Fig. 18) also suggest that, whilst there is a general increase in 
broadband and spectral noise with ship speed, noise is greater at 8 knots than at 10 knots.  Additional noise 
tests were performed at these two speeds, confirming this observation.   

 
It is worth noting that the initial JCR trial report makes reference to clear propeller cavitation between 
speeds of 6.5 and 8.3 knots (Section 5.2.1, Sea Trial Report, 7th-18th August, 1991).  At speeds greater than 
8.3 knots, broadband noise produced by cavitation was significantly reduced in frequency (from 2 kHz to 
200 Hz).  These observations may be related to air-flow patterns over the ship’s bow and could at least 
partially explain the results from the JRtri006 noise tests.   
 
Noise and Acoustic Instruments 
The results from the noise tests performed at 10 knots with addition of the various acoustic instruments 
are depicted in Fig. 19.  Broadband and spectral noises were slightly greater with addition of The Doppler 
logger, which transmits at a frequency of 307 kHz with a bandwidth of 25% and power into the water of 15-
20 W.  Addition of the ADCP, which transmits at a frequency of 75 kHz, also produced a small increase in 
broadband and spectral noise.  The EK60, which transmits at frequencies of 38 kHz, 120 kHz, and 200 kHz 
with power into the water of 2 kW, 500 W, and 200 W, respectively, had a minimal effect on noise.   
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Figure 18: Variations in broadband (above) and spectral noise (below) at different ship’s speed. 
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Figure 19: Variations in broadband noise and turning on different acoustic instruments (constant speed of 
10 kts, upper). Variations in spectral noise with different acoustic instruments running (lower). EM122 and 
EM122v2 were control tests with no other acoustic instruments running other than the swath. 
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Recommendations 
 
Results from the noise tests suggest that, in terms of minimising ship’s noise interference with the EM122, 
the optimal surveying ship speed is 10 knots. 
 
Outer sector errors are a significant problem for the EM122 system.  If high quality  seabed data is required 
a swath overlap of at least 25-30% is necessary to be able to cull poor data in the outermost parts of swath 
lines. 
 
Based on the data quality it is recommended that cleaning of the transducer heads is done as soon as 
possible and, if possible, the transducers are replaced (Note to check the forthcoming Kongsberg analyses 
on transducer performance). 
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Tests on Backscatter data derived from the EM122 (Kelly Hogan) 
 
The JRtri006 trials cruise provided an opportunity to test the backscatter (BS) data acquired by the newly 
upgraded EM122 multibeam swath bathymetry system.  The reason for analysing the BS data is because of 
several known issues with BS data collected by the previous EM120 system and with a current EM122 
system on the Swedish ice-breaker Oden.  
 
1. Different ping modes and backscatter values 
 
Known issues with EM120 backscatter 
 
Previous observations from EM120 backscatter data collected with the JCR’s EM120 have shown “steps” in 
backscatter values associated with changing the ping mode of the echosounder.  During normal data 
collection the EM120 was run in automatic mode consisting of 5 preset ping modes (Very Shallow, Shallow, 
Medium, Deep, Very Deep).  Tests on the EM120 BS during JR142 in 2006 revealed “steps” of around 4 dB 
in BS levels between the “Medium” and “Deep” ping modes of the EM120 system (e.g. BS values were 4 dB 
higher in the Deep mode; Dowdeswell, 2006). The “steps” were attributed to an increase in pulse length 
from 5 to 15 ms between the two modes.  No appreciable “steps” were observed between the shallower 
ping modes which all operate with a pulse length of 5 ms. 
 
EM122 backscatter – JRtri006 
 
For the new EM122 echosounder there are only four preset ping modes: Shallow, Medium, Deep and Very 
Deep (changed on-the-fly in Runtime Parameters).  When run in “Automatic” mode, the swath system 
determines the optimal mode based on water depth and the quality of the beam forming.  The thresholds 
between the different modes are as follows: 
 

• Shallow/Medium mode: 450 m 
• Medium/Deep: 1000 m 
• Deep/Very Deep mode: 1000-9000 m 
 
Transmit pulse length increases with depth from 2 ms to 15 ms continuous wave (CW) pulse and up to 100 
ms frequency modulated (FM) pulse.  Essentially this means that the pulse length for shallow mode is 2 ms, 
for medium mode it is 5 ms, and for deep mode it is 15 ms. Frequencies between 10 and 13.5 kHz are used 
across the sectors of each ping. Note that FM functionality is not yet available on the JCR (should be 
upgraded in 2012) so the “FM disable” box (in Depth Settings in Runtime Parameters) was checked 
throughout JRtri006 and any changes in BS caused by the switch from a CW to FM pulse in deeper waters 
could not be assessed. 
 
As the EM122 echosounder changes between different ping modes two things happen.  First, the pulse 
length increases in deeper waters. Note that the pulse lengths are actually different across the sectors of 
the swath (not in shallow mode where it is 2ms in each sector) with increasing pulse lengths from the nadir 
towards the outer sectors (4 sectors for Shallow and Medium mode; 8 sectors for Deep and Very Deep 
modes), and that the pulse length increase occurs instantly once the swath mode has been changed.  
Second, the frequencies emitted by the transducers are different for the different modes.  Like the pulse 
length the transducer frequency varies across-track e.g. outer sectors emit lower frequencies (this allows 
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the outer beams to travel further to the seafloor, which they need to do in order to reach and return from 
the seafloor owing to the slant-range).  However, unlike the change in pulse length, the change in 
frequencies is gradual and works from the outer beams inwards when switching to a deeper water mode. 
Therefore, any effect on backscatter values due to varying frequency should be less noticeable than effects 
from the changing pulse length. 
 
EM122 BS Tests 
 

 

Figure 20a (upper): Bathymetry of downslope transect for testing of ping modes, and Figure 20b (lower): 
Backscatter data, line locations and EM122 settings used during testing. 
 
In order to determine whether changing the ping mode affects backscatter values in the EM122 system a 
series of tests were run during JRtri006 on a down-slope transect.  Five consecutive lines were run for 0.5-1 
hour each with two lines in shallow mode, one in medium mode and two lines in deep modes (Lines 0000-
0004; Fig. 20).  Basic post-processing was applied to all of the lines using FMGT.  Angle Varying Gain (AVG) 
and beam pattern corrections were applied; the Tx/Rx Power Gain (radiometric) Correction was not applied 
(typical for EM120/EM122 type sonars; Fledermaus Reference Manual V7, 2011).  FMGT’s dual swath 
compensation function (the ability to use only the first or second ping in dual swath systems) was not used 
in this test. 
 
Three of the lines (0001, 0002 and 0003) were taken as representative of the different pinging modes for 
the EM122 (Fig. 20); all other settings of the EM122 remained constant during testing which was 
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performed at a speed of approximately 8-9 kts.  Average amplitude values were extracted for 5 groups of 
50 pings on either side of the line increment (i.e. when ping mode was changed) in order to compare BS 
values in different modes and in similar seafloor terrains (Figs. 21 and 22): 
 

 
Figure 21: Average amplitude values for 5 groups of 50 pings at the end of Line 0001 and at beginning of 
Line 0002.  Line 0001 was run in shallow mode, 0002 in medium mode. 
 

 
Figure 22: Average amplitude values for 5 groups of 50 pings at the end of Line 0002 and at beginning of 
Line 0003 over the change from medium to deep ping modes. 
 
From Figure 21 we can see that in general, there is good agreement between backscatter data values for 
data acquired in shallow and medium ping modes in areas with relatively little seafloor topography e.g. 
beam numbers 1-100 and 220-280.  This is in agreement with visual inspection of the data that revealed no 
significant jumps in data values (darkening or lightening between lines e.g. Fig. 20b). The rise in backscatter 
values to close to zero in the starboard outer beams is most likely real due to a shallowing of the seafloor in 
this location returning higher BS values and no return from the outermost beams. 
 
Figure 22 shows that there does not appear to be a consistent clustering of BS data values at different 
levels between the medium (red hues) and deep (green hues) ping modes.  BS values are 2-5 dB lower on 
the port side (beams 1-150) and peaks and troughs between Line 0002 and Line 0003 values seem slightly 
offset from one another.  This probably reflects real BS variations owing to the changing morphology of the 
seafloor down-slope and the data gap between Lines 0002 and 0003.  Again there was no evidence of data 
value “steps” from visual inspection of the semi-processed imagery.     
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Visual inspection and comparison of BS values indicates that the BS “steps” visible in EM120-derived BS 
data were not apparent in data collected by the new EM122 system.  More gradual changes in pulse length 
and frequencies across different sectors of the transmitted signal have probably helped alleviate this issue.   
 
2. Different swath modes: Single ping vs. dual ping 
 
Noisy BS data and/or second ping gain issues are known from EM122 dual ping swath data from the 
Swedish icebreaker Oden.  Therefore, we sought to test both the single and dual swath ping modes of the 
EM122 during JRtri006.   
The Kongsberg recommended setting for Dual Ping Mode (see Runtime Parameters) is Dynamic (Dual ping 
ON), which means that the along-track angle between two pings is based on vessel speed, ping rate and 
depth and that the EM122 aims to maintain uniform along-track sampling of the seafloor.  Note that dual 
pinging only initiates in >80 m water depth as it is not deemed necessary in shallow waters when you have 
high ping rates.  In addition, dual pinging is turned off in Very Deep swath mode because of duty cycle 
limitations of the transmit transducer (see SIS Reference Manual 3.8). 
  
The effect of dual pinging on the BS was tested by running two consecutive lines in similar water depths, 
the first with dual ping mode ON (Line 0003) and the second with dual ping mode OFF (Line 0004; Fig. 1b).  
The BS from these lines is shown in Figure 4.  
 
The excessive noise and gain issues in EM122 dual ping BS data from the Oden, which appear as blocky 
white stripes, were not observed in the EM122 data collected on JRtri006.  In general, the BS data quality 
was good although it is degraded in the outer beams.  This is related to the degradation of the transmitted 
(and thus received) outer beam signal of the EM122 on the JCR (see Data Quality section of) although we 
note that in a real swath survey overlap with adjacent lines would result in an improved BS mosaic.   

 
Figure 23a: Backscatter data acquired in dual ping and single ping modes with the EM122, black box shows 
inset location, and Figure 23b: Zoom to show the decrease in resolution between dual (RHS) and single (LHS) 
ping BS data. Gully edges are more “blurry” in single ping mode. 
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Of particular note is the decrease in resolution of the BS mosaic when in single ping mode (Fig. 23b). This is 
directly related to the increased data density that can be acquired with the EM122 data when compared 
with the old EM120 system.  The last feature to note is a band of elevated BS values on the outer edges of 
the swath data (arrowed in Fig. 23a). Draping the BS mosaic over the gridded bathymetry data in 
Fledermaus showed that this band is not related to topography of the gullies on the slope and the edge of 
this band seems too sharp and linear to be a real (seafloor) feature. In shallower water depths this linear 
transition appears as a dark (low intensity) band and seems to correspond to the transition to the outer 
sector of the transmitted swath pulse and the curve in the band edge may represent the location of the 
outer sector transition in varying topography.   
 

3. Absorption Coefficients 
 
Application of the correct absorption coefficient is important with respect to the validity of bottom 
backscatter measurements. In the EM122 system a new absorption coefficient is automatically created and 
applied every time that a new sound velocity profile is loaded into SIS and used during data acquisition.  
These profiles are also based on the salinity at the transducer head, which can be input in the Filter and 
Gains tab in Runtime Parameters in SIS (default 35 psu). A user-defined absorption coefficient can be input 
in the Sound Speed tab in Runtime Parameters.  Full descriptions of how to load absorption coefficient and 
how this is derived is given in the SIS Reference Manual (equation page 871). 
 
4. Recommendations 
 

• For highest resolution BS data dual swath mode should be left on DYNAMIC whilst surveying.  
• For BS surveys plan for good overlap of adjacent swaths to reduce outer beam errors in the final 

mosaic. 
• Users should be aware that sector differences in the transmitted frequencies of the swath system 

might affect BS data. 
• Because BS data quality is directly related to bathymetry data quality optimal bathymetry survey 

speeds for the JCR will likely produce the best BS mosaics as well.  
• For accurate absorption coefficients the correct salinity should be entered in Runtime Parameters. 

 

5. References 
Dowdeswell, J.A., 2006. RRS James Clark Ross Cruise Report – JR142: North and East Svalbard: Past Ice-
Sheet and Slide Activity. 
 
Fledermaus Reference Manual Version 7, 2011. www.ivs3d.com. 
 
Seafloor Information System SIS Reference Manual, Release 3.8, 2010.  SIS on-line help manual. 

http://www.ivs3d.com/�
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Water column data (Sophie Fielding) 
 
Water column data was not examined during the cruise because no software capable of looking at it 
existed on the JCR. However two sets of example files were collected, representative of the two water 
column logging modes of SIS. 
 

1) Water column data were logged to a separate file (from the .all) with ending .WCD. Data were 
recorded during the first roll calibration JRtri006_C 19:37 – 20:56 01/07/2011. This file collected 88 
MB of WCD files and 50 MB of .all files in approximately 90 minutes. 
 

2) Water column data were logged to the .all file in JRtri006_C 21:38 – 23:40 01/07/2011. Two .all 
files were saved each of 126 MB of data (256 in total) 
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Seafloor Information System – Useful Information (Gwen Newton) 
 
Kongsberg authored user and technical EM122 manuals are on board and they give a detailed description 
of the Seafloor Information System. In addition, Appendix C of this report provides a user guide to 
acquiring swath bathymetry on the James Clark Ross. Listed below are a few pieces of additional 
information that may not be found in the Kongsberg manuals. 
 
The Grid in Geographical View 
 
Whilst pinging and logging SIS automatically creates a grid of the data which can be viewed in the 
Geographical window.  
 
If multibeam is being monitored throughout the cruise and different surveys will be set up for shelf and 
deep water sections then the GridEngine parameters (under Runtime Parameters > Advanced Options) 
should be chosen with the following in mind. A typical choice for the number of cells in the processing grid 
is 128x128. The across track swath width can be estimated from the depth and the maximum angle of the 
beams using trigonometry. Finally, the Cell Size in m should be estimated as approx. swath width / number 
of cells in processing grid.  
 
Note: If the grid cell size is too small for the current conditions then black (apparently missing data) areas 
will appear in the grid in the Geographical Window. This does not necessarily mean that the multibeam isn’t 
working. However, it will make it harder to assess the quality of the data coming in. It is not possible to 
change the GridEngine Parameters of a survey once it has been started which is why it is so important that 
these are correct before starting the survey. If this problem occurs the Waterfall and Across track views 
should be used to assess the data instead.  
 
If you press the ‘I’ button (Inspection Mode) in the Geographical window then the grid will be displayed in 
the highest resolution no matter how far you are zoomed in our out. This uses a lot of memory and only a 
certain extent of the grid will be available to view in this mode, a white rectangle will define the extent. 
This mode should only be used for quick checks of the data. If it is left on there is a chance it will crash the 
grid. 
 
Setting a Suitable Depth Range 
 
Check that the Min. and Max. Depth range (Runtime Parameters > Sounder Main) is suitable for the area 
that you are going to be covering. The values should be half the water depth above and below the current 
depth i.e. in 1000m of water they should be set to 500m and 1500m. This helps the multibeam locate the 
bottom. If the bottom depths fall outside the min and max values set in the Runtime Parameters the Depth 
will be flagged red in the Numerical Display and you will notice that the centre beams drop out first. This 
can easily be fixed by updating the values in the Runtime Parameters or the Runtime Parameters Mini 
window.  
 
Additional Useful Points 
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FM Mode:  The EM122 has the capability to operate in FM mode which allows it to see further out to the 
side in deep water. On the JCR this function is not yet available and hence has been disabled in the system. 
In the future when the function become available it will be very important to ensure that the roll 
calibration and SVP are accurate. 
 
Water Column Logging:  If you would like to log water column data in a certain area you need to open the 
Show/Hide window for the Water Column and check the box to turn logging on. In the main toolbar the 
WCL button will turn green. In Installation Parameters > Output the current settings force the water 
column data to be logged to a separate file. These files are very large and hence water column logging 
should only be turned on when necessary. Remember to uncheck the box when you no longer need the 
data. 
 
Message Log:  The Message Log window can be opened at any time and will give you a list of all recent 
messages / warnings. If you encounter problems with the multibeam then this is a good place to get an 
idea of what the issue might be. 
 
Planning Module:  This can be used to define lines that you would like to survey. Before you start you need 
to make sure the ‘P’ button at the top of the window is checked. Once you are happy with the lines they 
can be transferred to the Helmsman Display so that they can be seen on the bridge. 
 
Background Grids:  It is possible to import your own background grids to be displayed in the Geographical 
window. This can be done by going to File > Import/Export. 
 
True Heave Logging:  It is possible to log the true heave of the vessel to a file which can then be used in 
post processing software. The true heave is taken from the SEAPATH system and is not calculated 
instantaneously. Hence if you would like to log true heave then you need to wait about an hour after 
starting the survey before turning it on. The logging is switched on via Runtime Parameters > GPS and 
Delayed Heave then tick the box ‘Start Seapath Real Heave logging’.  
  
Bugs:  If you chose to open the Runtime Parameters in a tear off window then it is likely that the system 
will crash (apparent when you can no longer use the drop down menus). If this happens you will have to 
shut down and restart SIS. Hence it is recommended that Runtime Parameters is never opened in a tear off 
window. 
 
Returning to a Previous Survey:  If you would like to go back to a previous survey and start logging to it 
again, there are two options. You can use a New Survey window and in the Basic Parameters tab you can 
choose your survey from the Existing Survey drop down and then press the ‘Continue on existing survey’ 
button. The survey will then appear in the far right box of the main toolbar and the correct line number will 
be displayed in the Line cnt. box. Alternatively you can choose the survey directly from the drop down box 
on the far right of the main toolbar. However, the line count will be incorrect until you turn pinging on.  
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Sound Velocity import (Alex Tate) 

The SIS software provides a large range of import options for sound velocity profiles collected by XBTs, 
CTDs and hull mounted sensors. These are well documented in the SIS user manual and this report will only 
describe the preferred method of importing Sippican XBT and Seabird CTD sound velocities as collected on 
the majority of JCR scientific cruises. 

Sippican XBTs 

Sippican T-5 (deep) and T-7 (shallow) XBTs can be deployed whilst the vessel is moving, preferably at 6 
knots to ensure a full depth profile. Launch instructions are located near the XBT acquisition machine and a 
successful deployment results in an .EDF and .RDF file being written to the current cruise XBT folder on the 
network (e.g. /data/cruise/jcr/20110627/xbt/T5_00002.EDF). 

A cron job (run under user ID, jcrdata) running every minute on the minute, searches for newly acquired 
xbt data and when found converts the .EDF file into an .asvp that can be read directly into SIS. The 
following steps are required to load the .asvp into the current EM122 survey file. 

1) From the SIS Tools menu select Tools menu and select Custom>SVP Editor 

2) Use File>Open and navigate to the U drive (named as em122)> asvp directory >cruise/<leg id> and 
select the latest XBT profile gathered. This is a samba link to /data/asvp/by-leg/<leg id> on the 
network. 

3) When loaded the profile can be edited to remove bad points, especially those points at the bottom 
of the profile where the XBT has hit the seabed before finishing recording. The profile screen can 
be zoomed by changing values in the from/to depth and sound speed boxes and hitting redraw. 
Multiple rows can be selected by using shift-click on the spreadsheet view before hitting delete 
row to remove them. 

4) When the profile is clean it needs to be extended to 12,000m using Tools>Extend Profile in order to 
satisfy SIS requirement. Using Tools>Check profile automatic will identify any problems points that 
have been missed. 

5) Use Tools>Thin Profile to reduce the number of points within the profile. Accept the 0.1 thinning 
ratio and the software will automatically reduce the number of points by 90 percent, leaving the 
most in areas of fastest sound velocity change within the profile. Note the EM122 can handle 
profiles with up to 1000 points in. A new file will be created in the current directory called 
<original_name>_thinned.asvp. This file will be automatically transferred to the EM122 machine 
under D:\sisdata\common\svp_abscoeff\<leg id>. The transfer is based on a chron job running 
every minute so there will be a brief delay before being able to select the profile. Close the SVP 
editor. 

6) In SIS Runtime parameters choose the Sound Speed tab and select the correct thinned profile from 
D:\sisdata\common\svp_abscoeff\<leg id>. Click ‘Use sound speed profile’ to apply the profile to 
the current survey line even while still logging. Note that auxiliary absorption coefficient files will 
be automatically created as the sound speed is applied and that the survey line count does not 
increment automatically. 



[36] 

 

Seabird CTDs 

Following the processing steps on the CTD computer, a batch file is run generating an .asvp file that is 
written to the /data/asvp directory. This can be selected in the same way as XBT data following the 
steps already mentioned. 

XBT/CTD sound velocity profiles for archival cruises will be added later in 2011 and can be selected in 
exactly the same way. 
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EM122 Post-processing software (Alex Tate) 
 
MB System v5.2.1880 
MB System successfully read and processed EM122 data. As with EM120 data, the function mbcopy is used 
to transfer raw files into an extended format that holds additional flag values. A perl script written by 
Jeremy Robst streamlines this task as well as producing auxiliary files. To run the script type, 
 
setup gsd 
mbcopy_em122 
 
Further details regarding processing with MB System can be found in a number of previous JCR cruise 
reports (see http://www.bodc.ac.uk/data/information_and_inventories/cruise_inventory/report/jr206.pdf 
for example).  
 
IVS 3D Fledermaus 
We were unable to secure a trial copy of IVS 3D Fledermaus for the cruise but a copy belonging to the Scott 
Polar Research Institute was available. Fledermaus successfully read and processed EM122 data (both 
raw.all and MB System .fbt files) but we did not have the FMMidwater module so no water column data 
could be viewed or processed.   
 
Kongsberg Neptune 
We were unable to get Neptune to read any of the new EM122 data files but this is unsurprising given that 
we have not had a Neptune upgrade in several years and that this software is no longer being developed. 
The primary use of Neptune in recent seasons has been to quickly visualise the current survey data. Now 
that this functionality is available within the SIS acquisition software, Neptune is effectively redundant. It is 
left on the JCR in case users bring archival swath data, processed within Neptune, and want to view/edit 
these data. 

http://www.bodc.ac.uk/data/information_and_inventories/cruise_inventory/report/jr206.pdf�
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Integration of EM122 with SSU and other instruments (Sophie Fielding) 
 
Over the course of the trials cruise the integration of the EM122, EA600, EK60 and ADCP through the SSU 
were examined and compared with the results from JR218 (JR218 Acoustic trials report). Each instrument 
was turned on individually and pinged under its own trigger control to ensure that it was operating. Each 
instrument was then turned on to trigger from the SSU and pinged. The EA600, ADCP and EK60 worked as 
desired. The EM122 did not trigger correctly through the SSU, Tx pulse and fixed time settings work okay, 
but the SSU did not appear to be receiving a release signal ready for the next trigger. The Kongsberg 
Engineer had to rewire the wiring between the EM122 and SSU due to broken wires. After this the EM122 
worked correctly with the SSU, allowing it to be used in calculated mode. 
One further trial was undertaken to examine whether the new EM122 could withstand being triggered by 
the SSU before it was ready. This was unsuccessful and the SSU should be used as described in the JR218 
report. It should be noted that THE EM122 AND EA600 NEED TO BE RUN THROUGH THE SSU TO PREVENT 
INTERFERENCE IN THE EM122 DATA. Below is a quick guide to SSU settings for each type of cruise. 

SSU Settings 

Opportunistic SSU mode and settings 

Setup Group Time usage 

EA600 (passive) EM122 EK60 ADCP 

Swath only EM&EA&EK&AD Tx pulse Calculated Off Off 

Swath + ADCP EM&EA&EK&AD Tx pulse Calculated Off Free running* 

Swath + EK60 EM&EA&EK&AD Tx pulse Calculated Free running Off 

* Free running – means not controlled by the SSU (on internal trigger) 

Opportunistic instrument settings 

Instrument Comments 

EA600 Needs to be in passive mode, external trigger, max ping rate 

EM122 External trigger, auto settings, may need to manually find depth at points 

EK60 Internal trigger, 2 second ping rate, interference removed in processing 

ADCP Water depth <500m load command file JCR_BT_opp.txt 

Water depth >500m load command file JCR_WC_opp.txt 

 

Biology cruise SSU mode and settings 

Setup Group Time usage 
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EA600 EM122 EK60 ADCP 

EK60+EA600 EM&EA&EK&AD Tx pulse (active) Off Calculated Off 

EK60+EA600+ADCP EM&EA&EK&AD Tx pulse (active) Off Calculated Tx pulse 

EK60+EA600+ADCP+EM122 

Water < 500 

EM&EA&EK&AD Tx pulse 
(passive) 

Tx pulse Calculated Tx pulse 

EK60+EA600+ADCP+EM122 

Water >500 

Shallow Tx pulse 
(passive) 

Fixed time 
(500ms) 

Calculated Tx pulse 

EK60+EA600+ADCP+EM122 

Water >2500 

Medium Tx pulse 
(passive) 

Fixed time 
(500ms) 

Calculated Tx pulse 

EK60+EA600+ADCP+EM122 

Water >5000 

Deep Tx pulse 
(passive) 

Fixed time 
(500ms) 

Calculated Tx pulse 

 

Biology cruise instrument settings 

Instrument Comments 

EA600 Need to be active, external trigger when EM122 off, otherwise passive, max ping 
rate 

EM122 Active mode, 60° beam fan on either side, auto settings, may need to manually find 
depth at points. Requires updating Sv profile if needed 

EK60 Water depths <500m use a 3 second ping rate, for depths >500m use 2 seconds* 

External trigger 

ADCP Water depth <250m load command file JCR_BT250.txt 

Water depth <500m load command file JCR_BT500.txt 

Water depth >500m load command file JCR_WC800.txt 

 

Geophysics SSU mode and settings 

Setup Group Time usage 

EA600 (passive) EM122 EK60 ADCP 

Swath only EM&EA&EK&AD Tx pulse Calculated Off Off 
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Swath + ADCP EM&EA&EK&AD Tx pulse Calculated Off Free running* 

Swath + EK60 EM&EA&EK&AD Tx pulse Calculated Free running Off 

* Free running – means not controlled by the SSU (on internal trigger) 

Geophysics instrument settings 

Instrument Comments 

EA600 Needs to be in passive mode, external trigger, maximum ping rate 

EM122 External trigger, controller changing settings 

EK60 Internal trigger, 2 second ping rate, interference removed in processing 

ADCP Water depth <250m load command file JCR_BT250.txt 

Water depth <500m load command file JCR_BT500.txt 

Water depth >500m load command file JCR_WC800.txt 

 
Physics cruise SSU mode and settings 

Setup Group Time usage 

EA600 EM122 EK60 ADCP 

ADCP+EA600 EM&EA&EK&AD Tx pulse (active) Off Off Calculated 

ADCP+EK60+EA600 EM&EA&EK&AD Tx pulse (active) Off Tx pulse Calculated 

ADCP+swath EM&EA&EK&AD Tx pulse 
(passive) 

Calculated Off Free 
running 

ADCP+EA600+EK60+EM122 

Water < 500 

EM&EA&EK&AD Tx pulse 
(passive) 

Tx pulse Tx pulse Calculated 

ADCP+EA600+EK60+EM122 

Water >500 

Shallow Tx pulse 
(passive) 

Fixed time 
(500ms) 

Tx pulse Calculated 

ADCP+EA600+EK60+EM122 

Water >2500 

Medium Tx pulse 
(passive) 

Fixed time 
(500ms) 

Tx pulse Calculated 

ADCP+EA600+EK60+EM122 

Water >5000 

Deep Tx pulse 
(passive) 

Fixed time 
(500ms) 

Tx pulse Calculated 

 

Physics cruise instrument settings 
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Instrument Comments 

EA600 Need to be active, external trigger when EM122 off, otherwise passive, max ping 
rate 

EM122 Active mode, 60° beam fan on either side, auto settings, may need to manually find 
depth at points. Requires updating Sv profile if needed 

EK60 External trigger, assumes 2 second ping rate 

ADCP Water depth <250m load command file JCR_BT250.txt* 

Water depth <500m load command file JCR_BT500.txt* 

Water depth >500m load command file JCR_WC800.txt* 

 

SSU integration diary 
 
Monday 27th June 2011 
EK60 fired up – initially no contact with GPTs. J noted netgear not turned on at GPT area. Once on EK60 
communicated with GPTs. All EK parameters working ok and IT sorted GPS string into the ER60 software. 
EM122 not working with SSU correctly. Not able to control through the SSU. Craig and Richard found 
cabling not wired correctly. 
 
Tuesday 28th June 2011 
ADCP fired up all working within parameters expected by novice user. 
SSU integrated EK60, ADCP and EA600 according to previous protocols. 
SSU now able to trigger EM122 when in either fixed time or tx pulse mode but not working with EM122 
when put in calculated mode. Appears not to see released signal. 
 
Wednesday 29th June 2011 
SSU now integrated with all instruments correctly. Can run EM&EA&EK&AD mode trigger all at rate of EK60 
(2 sec ping rate) all working together. Need to test whether EM122 no longer falls over if you try and 
trigger at the wrong time, because if not we can just use the EM&EA&EK&AD mode in the future 
controlling trigger rate by the EK60 and the EM122 not firing when not ready. 
 
Thursday 30th June 2011 
Examined whether EM122 failed when triggered when not quite ready. Put group EM&EA&EK&AD on SSU 
in ~1800 m of water. Ping rate 2 seconds controlled by EK60. EM122 failed to trigger and cope with 
repetitive triggering when not ready. The new dual pulse mode may make it more acceptable to have a 
slower EM122 ping rate interfaced with the other instruments. 
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Operating the swath and EA600 through the SSU (Sophie Fielding) 
 
The EM122 and EA600 must be run through the Simrad Synchronisation Unit (SSU) to prevent interference 
and noise in both (as they both work at the same frequency). Many of these stages can be completed 
through a chat with your friendly IT support. 
 
The SSU is located in the acoustic electronics cabinet, at the top. It is turned on using the black switch, after 
which the green power light lights up. The SSU monitor, situated on top of the cabinet, is shared with the 
Seapath GPS system and can be chosen by pressing the PC2 button on the KVM switch next to the monitor. 
The SSU is controlled either using the arrows on the attached (grey) keyboard or using the arrowed control 
handset. On start up the SSU boots to a mode selection menu, choose either “default” or allow to boot up 
into the auto selected mode. 
 
At the first screen select the second configuration (Photo 1) by using the arrow keys to navigate down and 
the right arrow key to select the option. This configuration is listed as EM&EA EK TO. Once up and running 
ensure both the EM122 and the EA600 are in external trigger mode, and the EA600 is set to passive (EA600 
note 1). Select GROUP (using the right arrow key), select EM EA (using the right arrow key), select EM120 
(using the right arrow key), select TRIGGER (using the right arrow key) and select ON. Check that the EM 
mode is set to calculated (select GROUP, EM EA, EM120, TIME USAGE, CALCULATED). Then set up the 
EA600 following GROUP, EM EA, EA600, TRIGGER, ON and GROUP, EM EA, EA600, TIME USAGE, TX PULSE. 
Start pinging on the EM122, the systems may take a minute to start pinging correctly. Eventually the SSU 
screen should look like photo 2 (in deep water – there will be more pings in shallow water). 
 
Photo 1 – select the group EM&EA EK TO at start up menu, Photo 2 – the SSU screen when the EM122 and 
EA600 are synchronised in deep water 
 

      
 
 
Note 1 - setting EA600 to passive 
Phone the bridge and ask the OOW to set the EA600 in passive mode on external trigger. Alternatively, 
inform the bridge of your intentions (and get them to press scroll lock if the light is lit up on the EA600 
keyboard), and apply the following 
File -> Operation -> tick/untick Extern trig and set ping rate to maximum 
Right click on ’12 kHz’ -> mode set to passive when synching with EM122 and back to active when the 
EM122 is off. 
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 Seatex Seapath 320+ (Alistair Graham) 
 

1. Introduction and Equipment Purpose 
 
The Seapath 320+ is a positioning, attitude and heading sensor, combining inertial measurements with 
satellite signals to achieve high precision information on the ship’s position and vessel motion. On JCR, the 
specific function of the Seapath is to measure heading, position, roll, pitch, heave and timing. The Seapath 
provides positional and inertial data for the EM122 multibeam echo-sounder.  
 
The Seapath is a GNSS system meaning it needs free sight to the sky to function correctly. For positioning at 
least 4 satellites are required for the Seapath to operate, and the accuracy of the position calculation varies 
with the number of visible satellites and their locations. The Seapath 320+ uses a combination of GPS and 
GLONASS GNS systems, meaning better geospatial coverage, particularly in operating environments with 
obstructions or otherwise poor satellite connection. Positional accuracy may be enhanced further using 
differential GPS/GLONASS corrections, which take account for small errors in satellite orbit by correcting 
from a reference station with known co-ordinates. The Seapath can also use the free-of-charge SBAS 
system to provide additional accuracy to the GPS system. 
 
The new Seapath was installed prior to cruise JRtri006, and trialled as part of the Kongsberg EM122 
multibeam echo-sounder acceptance trials. For a detailed user guide and further information refer to the 
Seapath 320+ Product Manual. 
 
2. Components       
 
The main components of the Seapath 320+ are: 
 

• The MRU 5+ inertial sensor  
• Two GNSS antenna. 
• The two-module Seapath product in the UIC room, comprising separate Processing and HMI 

(Human-Machine Interface) units, connected via Ethernet. The units are rack-mounted in the black 
cabinet directly behind the EM122 and TOPAS workstations. The terminal for the Seapath HMI is on 
top of the black computer cabinet. 

 
3. Usage 
 
Power on/off switches for the units are located on their front panels, under flick lids. 
  
The HMI will be used for system configuration and visualisation of data related to JCR’s GPS inputs, attitude 
and heading. The operator software is intuitive and easy to use, running on a Windows XP platform. The 
system has three user modes: Operation (the default user mode), Configuration and Engineering. The main 
features are accessible in all three modes, but substantive changes to the system can only be made in 
Engineering mode. A password is required to access the advanced user modes. Most users will only require 
the features offered in the Operation mode (see p. 27 of the manual for info on system modes). 
 
4. Useful features and points-of-interest 
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The software is described in detail in the user manual, and user instructions are not repeated here. 
However, some features that will be immediately useful are: 
 
Changing data views on the HMI 

The main display is divided into 4 view windows: the top bar, main display (view 1), view 2 and 
view 3. Combinations of shortcuts F2, F3, shift+F2, and shift+F3, cycle and switch between the different 
views. See page 26 of the manual.  
 
 
Assessing data quality and status 
 
Seapath has a real-time quality control feature for monitoring data quality. The left part of the top bar on 
the NavEngine display has a number of status indicators for Pos/Vel, Heading, Heave, Roll/Pitch, and 
system status. If these are green, then status is normal. For all indicators except the system status, alarms 
are triggered if quality degrades or thresholds are passed, resulting in the indicator turning yellow. This 
indicates reduced performance. Red alarms indicate the data are invalid. See p. 41 of manual for info on 
Alarms.  
 
N.B. The thresholds for alarms are set low on the JCR. ‘Yellow’ alarms are not uncommon and do not 
usually signify that data quality is compromised. It is likely that when South, such alarms will be a regular 
occurrence requiring no further action. Nevertheless, the operator should still take note of alarms and 
verify that data quality remains adequate. Red alarms will still require action. 
 
The ‘Integrity’ view is a useful quick visualisation of the system accuracy. 
 
Looking at available satellite coverage (Sky View) 
 
The Sky view shows which satellites the system is tracking and which are being used in the position 
calculation. The large numbers to the top left and right show these information for GPS and GLONASS 
respectively. Hovering over the circular satellite markers provides further details on individual satellites. 
See p. 29 of manual. 
 
Looking at real-time motion and heading data (Motion Data view) 
 
Shows real-time values for the inertial measurements, including speed and heading, and rate of turn.  
  
Planning for satellite drop-outs (Satellite Prediction) 
 
A tool to display satellite numbers and geometry for a defined position and period of time. Useful for 
planning, to see likely future positional accuracy and to predict satellite drop-outs. Drag the time indicator 
bar to see the constellation change, or insert a manual time and position and click update.  Shadow sectors 
can also be manually inserted, to account for shadowing by nearby obstacles. See p. 44 of manual.  
 
Changing display modes (e.g. at night-time) 
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Found in the View menu, or by toggling F7 (for 4 different day settings) or F8 (for night view). Allows user 
to change display colours in varying light conditions. 
 
5. Performance report 
 
No problems were reported with the Seapath during cruise JRtri006. In UK waters, we enabled the SBAS 
corrections, which improved our positional accuracy. It was noted by several of the science party that the 
Seapath 320+ was a significant improvement over the old system, in terms of information relay and user-
friendliness.  
 
6. Recommendations     
 

• GNSS heading should be properly calibrated in next dry dock. 
 

• Configuration files should be saved and stored routinely after each JCR cruise. 
 

• Thresholds for ‘yellow’ warnings could be reduced to avoid repeated alarms.  
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ICT Cruise Report (Jeremy Robst) 
 
The onboard ICT wiki has been updated with procedures and notes relating to the multibeam upgrade.  
Modifications have been made to the processes for backing up the EM122 data from the operator 
workstation to the central fileserver (JRLB) and for generating sound velocity profiles from XBTs and CTDs. 
(Note no CTDs where performed during the trials cruise, so whilst the SVP import should work this has not 
been tested). 
 
The MBSystem processing software was upgraded (to version 5.2.1880) on JRUJ and on JRLD. The 
associated GMT package was upgrade to version 4.5.6. An ‘mb’ user was created for mb processing by 
scientists without a personal unix account. 
 
Separately to the EM122 upgrade, the SCS was also upgraded to v4.5.1.1603 and the trials cruise was used 
to test out this new version. 

Recommendations 
EM122 Operator Workstation 
 

1. Mirror the system disk. The operator workstation contains 2 (1TB) disks, one used for the OS and 
raw survey data, and one used for the automatically generated grid files. The OS & raw data disk at 
least should be mirrored to another disk so that the system will continue to work in the event of a 
disk failure. 

2. Bare-metal image the system. For disaster recovery, a bare-metal image needs to be made on a 
regular basis (once per year) and kept in the computer office. 

 
UIC AME/EM122 Cabinets 
 

1. Network patch panel and switch. Temporary cat5 cables have been run for the network & KVMs, 
however a proper patch panel and possibly a switch needs to be installed. 

 
Plotter 
 

1. Turn 90 degrees. The new position of the plotter means it has turned 90 degrees relative to the old 
position. This might make it vulnerable to the ship roll; if this happens then it should be 
remounted. 

 
Unix/Linux Workstations 
 

1. General purpose Linux workstation. The Solaris workstations (JRUH/JRUJ) are now quite old and 
struggle to handle the volumes of data being generated, and it is also a struggle to compile 
software on them. There is a virtual general purpose linux machine (JRLD), however it may prove 
more useful to replace the Solaris workstations with a physical linux workstation. 

 
SCS/Instruments 
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1. Ashtech GPS replacement. The Ashtech GPS provided wildly inaccurate headings during the trials 
cruise, and for several years has needed rebooting every few days. Either a replacement GPS needs 
to be installed or the Ashtech needs to be removed – the Seatex Seapath system is a very good 3D 
GPS so the Ashtech is probably no longer needed. 

2. Truewind. The derived truewind sensor doesn’t appear to work in the new SCS version so an 
alternate means of providing true wind needs to be investigated. 
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Recommendations 
Individual sections have their own recommendations in context but they are repeated here for 
completeness. 
 
EM122 calibration 

• Calibration of the sensors should be performed at the beginning of every dedicated multibeam 
survey. As a minimum, a roll check should be carried out before any cruise which involves 
substantial multibeam data acquisition.  

 

• If no geophysics cruises are scheduled, calibration should still be performed at least once per year 
and certainly after any modifications to the sensors (e.g. during refit).  

 

• Areas should be identified near to operational bases and ports where calibration of the EM122 can 
be conducted and repeated at regular intervals. 
 

EM122 data quality 
• Results from the noise tests suggest that, in terms of minimising ship’s noise interference with the 

EM122, the optimal surveying ship speed is 10 knots. 
 

• Outer sector errors are a significant problem for the EM122 system.  If high quality of seabed data 
is required a swath overlap of at least 25-30% is necessary to be able to cull poor data in the 
outermost parts of swath lines. 

 
• Based on the data quality it is recommended that cleaning of the transducer heads is done as soon 

as possible and, if possible, the transducers are replaced. 
 
EM122 backscatter data 

• For highest resolution BS data dual swath mode should be left on DYNAMIC whilst surveying.  
 

• For BS surveys plan for good overlap of adjacent swaths to reduce outer beam errors in the final 
mosaic. 

 
• Users should be aware that sector differences in the transmitted frequencies of the swath system 

might affect BS data. 
 

• Because BS data quality is directly related to bathymetry data quality optimal bathymetry survey 
speeds for the JCR will likely produce the best BS mosaics as well.  

 
• For accurate absorption coefficients the correct salinity should be entered in Runtime Parameters. 

 
EM122 sound velocity import 

• Add archival xbt/ctd data into the new directories used to import sound velocity information into 
SIS. 

• Investigate bringing sound velocity data collected by the Oceanlogger (via the SCS) into SIS using a 
free COM port. This would give a visual indication when the sound velocity at the hull deviates 
significantly from the sound velocity profile being used. 

• Investigate costs of installing a Kongsberg sound velocity probe positioned near the EM122 
transducer. 

 
Seatex Seapath 320+ 
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• GNSS heading should be properly calibrated in next dry dock. 
 

• Configuration files should be saved and stored routinely after each JCR cruise. 
 

• Thresholds for ‘yellow’ warnings could be reduced to avoid repeated alarms.  
 
EM122 Operator Workstation 

• Mirror the system disk. The operator workstation contains 2 (1TB) disks, one used for the OS and 
raw survey data, and one used for the automatically generated grid files. The OS & raw data disk at 
least should be mirrored to another disk so that the system will continue to work in the event of a 
disk failure. 

• Bare-metal image the system. For disaster recovery, a bare-metal image needs to be made on a 
regular basis (once per year) and kept in the computer office. 

 

Conclusions 
 
The cruise was successful in that the majority of the objectives were completed and the EM122 upgrade 
was accepted from a technical and scientific viewpoint. A range of different users now have first-hand 
knowledge of the EM122 and the SIS acquisition software and hopefully this report will help those not 
present to use the upgraded system in its first few seasons. 
 
As stated in the acceptance testimonial (see Appendix B), there is significant concern about poor data seen 
in the EM122 outer beams. Impedance measurements on the EM122 Tx (and to a lesser extent Rx) 
elements suggest significant degradation rates especially in the middle sectors, reducing the signal strength 
and impeding beam formation.  
 
Consequently the main conclusion and recommendation of this report is that the Tx transducer array 
should be replaced as soon as possible. 
 
Kongsberg will perform further analysis using data acquired on this cruise and any future technical report 
will be appended to this document. 
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Appendix A – Kongsberg Technical Report (Craig Wallace) 

 

Seapath 

The Seapath 320+ has been installed in the same rack as the HWS machine for the EM and Topaz 
and is replacing and older Seapath200. The old unit was already removed prior to arrival so it is not clear 
which systems all received feeds from the unit however the .par configuration file was removed and 
cabling matched to the outputs. I believe all systems which had an input previously have been catered for 
but cannot be 100% sure. 

As the unit replaces and older system it was necessary to determine a vessel dimensional control. The new 
MRU5+ has been located immediately beside the old MRU5 which has been left in place and may be 
utilised at a later date. From the old configuration file the previous vessel measure point was the old MRU 
so to ensure that all systems expecting data at this reference have no lever errors this location remains the 
Navigation point for the new Seapath. 

Parker Survey were employed to perform a survey for the vessel taking into account all the Seapath unit 
locations. This was provided in reference to frame 76. 

It should be noted that with the vessel not being in dry-dock a measurement for the Em122 transducers 
was not possible and these levers have been taken from the original Dim Con report in 2000. Unfortunately 
the vessels chosen reference has changed over the years and whilst we believe the transducers 
measurements to be accurate we cannot be 100% sure until a full survey is performed at the next dry 
docking. 

The table below shows the results from the Surveyors which are referenced to frame 76 at the keel whilst 
the second table shows the measurements transposed to the stern point.  

      

  
X +ve 
For 

Y +ve 
Star 

Z +ve 
down 

Yaw +ve 
clock 

Pitch +ve 
Fore up 

Roll +ve 

 Port up 

MRU5+ -1.165 -0.191 -7.105 2.74 -0.02 -0.03 

MRU5 -1.212 0.006 -7.558 1.33 0.01 -0.72 

320 Aft Ant -19.164 0.71 -41.271 0.7     

320 ForW Ant -16.665 0.741 -41.268       

Stern/origin -56.4 0 0       

Frame 76 0 0 0       

       
       

  
X +ve 
For 

Y +ve 
Star 

Z +ve 
down 

Yaw +ve 
clock 

Pitch +ve 
Fore up 

Roll +ve 
Port up 
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MRU5+ 55.235 -0.191 7.105 2.74 -0.02 -0.03 

MRU5 55.188 0.006 7.558 1.33 0.01 -0.72 

320 Aft Ant 37.236 0.71 -41.271 0.7     

320 Forw Ant 39.735 0.741 -41.268       

Stern/origin 0 0 0       

Frame 76 56.4 0 0       

 

 

Using the above values from the stern the Seapath was configured to output data valid to the MRU5. Note 
that Antennae one is the Aft and therefore the heading offset of 0.7 degrees is clockwise. The diagram 
below from the survey report shows the error, 

With the Seapath running it was 
necessary to apply this offset 
however it should be noted that 
the error in the Seapath is a C-O 
error so the applied value is 
what is needed to correct the 
system hence a value of -0.7 has 
been applied to the unit.  

 

A baseline calibration was 
performed to find any error in 

the baseline length and height however since the vessel was floating at quayside a proper surveyed in 
calibration could not be performed. Again this is something that should be performed at the next dry dock 
visit. After the cal the baseline error of 2.502 in length and 0.017 for height has been applied. 

 

 

The mounting angles for the 
new MRU5+ were installed into 
the software as shown in the 
picture across.  

It should be noted that any 
other systems receiving a 
Roll/Pitch signal will require a 
recalibration to take account.  
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To my knowledge the only systems this will be necessary for will be the Topaz unit and the Sonardyne USBL 
system. 

 

The outputs from the Seapath have been configured as follows, 

 

Telegrams Out Type Settings Details 

1 Serial Com 9, 19200, 232 Position and Time to EM122 

2 Serial Com 9, 19200, 232 EM3000 Attitude to EM122 

3 Ethernet UDP Lan3, 3001 FM correction to EM122 

4 Serial Com11, 4800 232 Feed to AIS (via 422 adapter) and SCS 

5 Serial Com 1, 19200, 232 EM3000 output to USBL (via 422 adapter) 

6 Serial Com12, 19200, 422 Position, Time etc to USBL 

7 Serial Com13, 19200, 232 EM3000 to Topaz 

8 Serial Com2, 19200, 232 GPS feed to Topaz 

 

The vessel has several outputs which are daisy chained where it would be much better to use serial 
splitters and it is recommended that this implemented in the future. 

With the system setup as above both GPS and Glonass satellites were detected without issue with good 
SNR on both constellations. Unfortunately the vessel does not use diff corrections meaning that the 
position error is usually greater than 2.5 metres and will leave the system in a reduced mode, this does not 
affect nay output strings merely gives a yellow indicator on the screen. On top of this the integrity value 
will always be quite high, again putting the system into a cautious mode. The new Seapath error limits are 
obviously quite tight and not suited to operation without DGPS however it will not affect any data outputs 
so can generally be disregarded. 

 

EM122 

Upon arrival original EM120 TRU had been removed and new 122 unit had been mounted. Due to 
mounting restrictions the new transceiver location differs from the original and cable paths had to be 
altered for termination. 

All Tx module connections were removed from the Tx junction boxes and all locations noted. The system 
has been installed sequentially with the lowest serial numbers towards the fore of the vessel. Similarly the 
Rx has been installed with the modules increasing in serial number from Port to Starboard. 
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The impedance of each element was tested and plots produced across the operational frequency of the 
transducers. These plots were subsequently sent to Norway for simulation. It should be noted that a high 
number of elements located around the centre of the TX array showed significant signs of degradation 
which indicates that the system would struggle to achieve a wide swath and would struggle to reach the 
greater extent of the expected depths for any particular mode. The Rx channels showed fairly good results 
with only a few questionable elements. The graphs of these measurements has been included at the end of 
this document. 

A full report indicating the extent of damaged elements will be issued by Kongsberg but until then the FM 
mode of the system has been disabled in the TRU, not just in the runtime menu. It should be noted that 
this will need to be edited upon installation of new transducers. 

With the elements tested all cabling was terminated in the Tx junction boxes/Rx pre amp and inside the 
transceiver cabinet. 

 

As shown the system retains the original Tx 
junction boxes and pre-amplifier, due to the 
greater Bandwidth used by the EM122 all 
amplifier/filter cards within the transceiver 
have been replaced with the newer 
versions. 

 

 

 

 

Old Cards Replacements 

78254 676886 

78252 676894 

78253 673013 

Blank 676013 

76949 673009 

76948 676885 

76950 673010 

76951 676891 
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The following tables give the various transducer connections within the system. 

Tx 
Module 

TX No T No Rio No 

984 25 T13 R7 J3 

985 26 

986 27 T14 R7 J4 

992 28 

994 29 T15 R8 J3 

995 30 

996 31 T16 R8 J4 

997 32 

998 33 T17 R9 J3 

999 34 

1005 35 T18 R9 J4 

1006 36 

1016 37 T19 R10 J3 

1017 38 

1023 39 T20 R10 J4 

1024 40 

1025 41 T21 R11 J3 

1026 42 

1028 43 T22 R11 J4 

1029 44 

1030 45 T23 R12 J3 

1032 46 

1033 47 T24 R12 J4 

1035 48 

Tx 
Module 

TX No T No Rio No 

931 1 T1 R1 J3 

952 2 

953 3 T2 R1 J4 

956 4 

958 5 T3 R2 J3 

963 6 

964 7 T4 R2 J4 

965 8 

966 9 T5 R3 J3 

968 10 

969 11 T6 R3 J4 

970 12 

972 13 T7 R4 J3 

973 14 

974 15 T8 R4 J4 

975 16 

976 17 T9 R5 J3 

977 18 

978 19 T10 R5 J4 

979 20 

980 21 T11 R6 J3 

981 22 

982 23 T12 R6 J4 

983 24 
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The inputs to the system were then terminated. Although the terminations are still D_Sub connectors 
unfortunately there was not enough length and all cables had to be extended using Cat 5 network cable. 
This has been secured to help prevent vibration however it should be noted that the cable is single 
stranded and could prove brittle after several years in a soldered connector.  

The system was configured with GPS input on com 1 which contained ZDA and VTG in the string at 19200 
whilst the Com 2 receives attitude in EM3000 format at 100Hz 19220 Baud. 

A PPS signal direct from the Seapath has also been implemented. 

The primary Ethernet port is connected to the topside HWS via crossed network cable for SIS and the 
secondary port connects to the Seapath to receive the Seapath binary format 11 telegram for FM 
corrections. 

The final input was for the remote on/off and synchronisation signals from the SSU. 

These are both fed in on a 9 pin D SUB and it should be noted that the pin outs have changed from the 
EM120 system. These are as follows. 

 

Note that the remote On/Off using pins 3,4 and 
5 remains unchanged and has been tested as 
operational. 

The EM 120 used pin 8 as ground for the 232 
signals whilst RTS and CTS were pins 6 and 7 
respectively so these have been re-soldered 
within the connector to match the EM122. 

Rx Module Rx No R No Rear IO 

121 1 R1 R1 J3 

124 2 

125 3 R1 R1 J4 

126 4 

127 5 R2 R2 J3 

128 6 

129 7 R2 R2 J4 

130 8 

Rx Module Rx No R No Rear IO 

131 9 R3 R3 J3 

132 10 

133 11 R3 R3 J4 

134 12 

135 13 R4 R4 J3 

136 14 

137 15 R4 R4 J4 

138 16 

EM122 Remote/Sync 
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It should also be noted that connection to the SSU previously used a common reference ground for both 
the TTL signals and the 232 signals. This did not work correctly with the EM122 and a separate ground path 
had to be used. Note the current interface to the SSU has been rewired and tested. The new wiring 
interconnect is shown below, 

 

 

 

 

 

 

 

 

  

 

With the system installed and all inputs verified the vessel sailed to perform sea trials. 

Initially due to the shallow waters the system showed large amounts of interference in the outer sectors, 
initially this was attributed to the water depth however as the depth increased the noise became quite 
prominent in the outer sectors. 

This picture shows the noise which 
causes large errors in the outer 
beams. It should be noted that in 
shallow water the energy in the 
central 5 degrees gives a large spike 
of noise. To try reduce this various 
settings were changed such as the Tx 
angle and various filters but without 

any effect. 

 

 

To try and better understand the 
problem various noise tests were 
done at variable speeds. The vessel 
has a single fixed pitch prop and is 
driven through electric drives. The 
graph below shows the noise at 

40  

6  

25  

5  

8  

10Kohm 

2  

7  

1  

2  

SSU Bus/Connector EM122 DB 9 

+12V 

CTS  Output Ch1+ 

Input Ch1+ Trig Out 

Input Ch1- 

Gnd 

TTL Gnd 

8  

6  

7  

Input Ch2 + 

RTS 

Input Ch2 - 

RTS Ref Gnd 



[57] 

 

increasing speeds all done in 2000m of water. It clearly shows a general increase in noise through the 
speed range as expected with a small sweet spot at 10 knots. The dramatic increase of noise in Boards 1 
and 2 which represent the outer edges of the Rx array suggests that the vessel suffers from considerable 
flow noise, i.e.; vortices which cross the face of the transducers until we reach higher speeds whereby they 
clear the edges of the array. 

The data subsequently collected confirms that the issue lies in the outer sectors with quite large artefacts 
in the outer sectors. Initially theses errors appear to be a roll/heading error however the central region of 
the swath is very stable giving good data with no oscillations.  

Various tests were done such as logging data at various speeds with fixed beam angles which showed that 
the system struggled to keep a full swath as the speed increased. This again indicates a noise issue however 
the values shown although high are not enough to cause the issues observed and it is more likely cause by 
a very low SNR. 

Again at this stage we are essentially guessing but it is believed that reduced performance of the 
transducers is causing a drop in the transmission pulse and quite possibly due to the failed central 
elements giving larger side lobe interference which is causing the tracking issues in the outer sectors. All 
the data will be post processed to try and find the cause of the interference, once the current element 
values have been simulated in Norway we will hopefully see that the results tie in with the real data. 

Despite this the vessel performed a full calibration followed by 3 by 1 patch test. Unfortunately the 
weather had increased considerably so the lines had to be run at a greater speed which in turn increased 
the noise. Roll and pitch cals gave good results as were able to rely on the central beams however the 
heading calibration was very due to the noise in the outer sectors. Despite this however no attitude 
artefacts were found in the data and good results were obtained. 

The final system settings are as below. 

 

System serial numbers 

EM122 TRU  sn  120 

HWS 14   343246             sn1011      

 

Current software versions  

SIS 3.8.3 build 89 

CPU 1.2.3 

DDS 3.5.2 

BSP 2.2.3 

RX 1.11 

TX`  1.11   
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COM PORTS AND LOCATION OFFSETS 

It should be noticed that the output from the Seapath has been referenced to the MRU5 not the MRU5+. Note that  X 
is +’ve forward, Y is +’ve starboard and Z is +’ve downward. 

          X y z 

COM 1  SEAPATH 320  GPS,ZDA 19200,8,n,1  0 0 0 
COM 2  EM3000 Attitude       19200,8,n,1             0       0 0 
Tx Sonar Array               6.369       1.3861    7.5486 
Rx Sonar Array             11.3618    -0.0056   7.4783 
Waterline                                0.755 
1 PPS  SEAPATH 320+ 
 

ANGULAR OFFSETS 

     ROLL   PITCH   HEADING 
TX                  0.05                  0.02        0.01 
RX                  0.04                  0.11        0.01 
SEAPATH MRU    0.17     0.0        -0.6 
 

EXTERNAL SENSORS 

None configured however a null modem has been linked between this HWS14 com 3 and the Topaz HWS12.  

When setting up the Topaz it will be necessary to output the depth telegram in external sensors. 

 

Network  

TRU Connection – 157.237.2.30 

Vessel connection – 10.104.254.224 

All system settings have been copied from the vessel and will be attached to the KM service desk for future reference. 
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Appendix B - EM122 Acceptance testimonial text (Alex Tate) 

The EM122 acceptance test formed the main part of the RRS James Clark Ross trials cruise JRtri006. Full 
details of the trials undertaken and preliminary results can be found in the JRtri006 cruise report. In 
summary the EM122 installation has been accepted while noting that there are significant issues with poor 
data in the outer beams. Data collected during the acceptance tests have been passed to Kongsberg for 
further analysis. Impedance measurements on the EM122 Tx and Rx elements suggest significant 
degradation rates especially in the middle sectors, reducing the signal strength and impeding beam 
formation. However, it is accepted that the EM122 is performing as well as it can given the degraded state 
of the transducers (installed during 2005). 

Calibrations were performed successfully and motion correction is being applied correctly. Noise tests were 
performed satisfactorily but there was limited scope to perform noise tests in a variety of sea states given 
the short duration of the trial cruise. 

This testimonial acknowledges the significant effort put in by Craig Wallace, the Kongsberg installation 
engineer aboard the trails cruise. His time and patience explaining both the EM122 system and the newly 
installed SIS acquisition software to the cruise participants was much appreciated. 
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Appendix C - Using the EM122 Multibeam on an Opportunistic Basis  
(Gwen Newton and Alex Tate) 
 
This guide will continue to be updated in the future as we gain more experience with the EM122. It will be 
available as a stand-alone document on the ship and is included here for the sake of completeness. 
  
Background Information 
 
The multibeam swath on the JCR is now operated through a windows based program called Seafloor 
Information System (SIS). The system is capable of operating several instruments simultaneously. However, 
on the JCR we only have one system the EM122 and its serial number is 120, hence in SIS it appears as 
EM122_120. The full reference manual for SIS is available at:  
http://www.jcr.nerc-bas.ac.uk/docs/computing/em122/EM_reference_manual.pdf 
 
Event Log 
 
If you are using the EM122 then you should have a dedicated event log for it (see ITS for how to set up and 
event log). As a minimum please record when you start and stop logging, when you change to a new survey 
and when you update the SVP. 
 
Turning the System On 
 
Open the glass door of the multibeam computer housing. Lift the flap over the EM122 button and press it. 
The button should light up red. Turn on the HWS 14 (Hydrographic Work Station) machine (sits below the 
button for the EM122 and the ON button is behind a door on the right). Turn on both of the EM122 
monitors. Wait for five minutes for the EM122 to boot up. From the start menu select SIS (Seafloor 
Information System) and the SIS user interface should open. Alternatively click on the quick link, a square 
icon of bathymetry. 
 
Note: An Unknown Publisher pop up will appear when you start SIS. Always choose ‘Yes’ and the system will 
open. 
 
The SIS interface has a menu bar along the top and seven frames (each containing one of 13 possible 
windows). A useful set up for carrying out an opportunistic multibeam survey on the JCR has been saved. 
This can be opened by choosing JCR_opportunistic from the drop down list in the top left hand corner of 
the menu bar.  
 
Preliminary Checks  
 
The following preliminary checks should always be carried out prior to starting the survey: 
On the main toolbar the dropdown box (which will currently read Not Started) to the right of the ‘Rescan’ 
button should be changed so that EM122_120 is selected. After 20 -30 seconds the name EM122_120 
should turn from red to black. To the right of this the three status lamps should turn green.  
 

http://www.jcr.nerc-bas.ac.uk/docs/computing/em122/EM_reference_manual.pdf�
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Note: The option for EM122_120 should appear in the ‘Not Started’ list about 5 mins after the system is 
turned on. If it has not appeared then press the rescan button and wait at least 10 mins. If the option still 
does not appear then there may be a network issue – contact ITS. 
 
From the main toolbar select View > Tear Off > Installation Parameters. The installation parameters should 
open in a new window. Click on the tab labelled BIST (Built-In Self Tests). Press the ‘Clear All’ button to 
clear the results of any previous tests. Run each test in order by clicking the buttons one by one (do not 
press the ‘Run all BIST’s’ button as the software may cause a test to start before the preceding one has 
finished, which could result in a false failed test). Wait for one test to finish before starting the next one. 
Some tests may take a while to run but it is worth taking the time to do this prior to starting the 
multibeam. There are currently some failed channels in the transceiver unit on the JCR. These will show up 
as failed during test 7, the TX Channels test, but do not hamper the operation of the swath. All the other 
tests should be successful and the buttons should turn green. If one fails the results will be displayed in the 
‘PU BIST result’ field and you should consult the manual or contact ITS. When all BIST’s have finished 
running save the results of the tests by pressing the ‘Save’ button. The results should be saved in 
D:/sisdata/common/bist and called after the survey name and the date e.g. jr105_a_01012011. The 
Installation Parameters window can then be closed. Take care not to accidently alter anything in the other 
tabs of this window. 
 
Note: The noise test (Test 8) is set so that it will fail if the background noise is above 80dB. If this occurs then 
the first check to make is that the EA600 (the single beam echosounder) is running in passive mode. If this 
has been verified then try doing the test again. Ideally a value of 40-50dB is best but the multibeam can 
function with noise up to about 80 dB. 
 
Finally, start the multibeam pinging by pressing the red ‘Not Pinging’ button on the main toolbar. The 
button should turn green and you should see data appearing in the Geographical, the Water Column, the 
Beam Intensity and the Cross track windows. 
 
Starting a new survey 
 
To start a new survey, change the Cross Track window to a New Survey window using the drop down menu 
in the top right corner of the Cross Track window. In the Basic Parameters tab choose the Default template 
by selecting it from the drop down menu. Add a survey name in the box. A typical name for a survey should 
start with the JCR cruise ID and then involve sequential letters, i.e. jr153_a, jr153_b etc. The locations of 
these should be described in the cruise report. Survey names based on physical locations are only 
meaningful at the time and can become confusing when the data is used in later years. If you are not doing 
a dedicated multibeam cruise and will not be splitting the cruise into individual surveys then the cruise ID is 
enough.  
 
If you feel it will be helpful then you can also add a comment in at this time.  
 
The SIS system creates grids of the data as it is collected which can be seen in the Geographical window. 
The parameters for the gridding are set up when you define a new survey. Hence, these parameters must 
be valid for all depths that you will encounter in the survey.  
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If multibeam is being recorded on an opportunistic basis and only one survey will be used during the whole 
cruise then the grid options should be set as follows:  
 
In the new survey window choose Advanced Options > GridEngine Parameters. The depth variable should 
always be set as ‘Z’. Set the ‘Number of Cells in Processing Grid’  to: 128x128. Set the ‘Cell Size in m’ to 120.  
 
Note: In the JCR_opportunistic layout the grid in the Geographical view is completely transparent. Instead 
you will see the real time depths. This has been set up because a coarse grid is required to allow for the 
range of depths which will be encountered. Hence visual display of the grid is not useful for assessing data 
quality. 
 
When you are happy with the naming and gridding of the survey go back to the Basic Parameters tab and 
click ‘Save new survey’. This will make your survey the current survey and the name will appear in both the 
second left and the far right boxes on the main toolbar. The box to the right of the ‘Line cnt.’ button should 
read 0000 if you are starting a new survey. If the line counter is not correct then you can click in the box 
and change it manually. The next box to the right should read 60 (the time in minutes before the line is 
incremented to the next number). Finally, change the New Survey window back to a Cross Track window 
using the drop down menu in the top right of the window. 
 
Note: You should not have to change any of the storage options or Advanced Options (other than the 
GridEngine Parameters) as these will be defined for you in the default. 
 
Checking the SVP 
Before commencing logging it is necessary to check that the sound velocity profile (SVP) is representative 
of the local water conditions. This is best done by looking at the Cross Track window and checking whether 
the sea bottom profile looks like either a smile or a frown. If so then the SVP is probably wrong. Refer to 
the section below called ‘Updating the SVP’ to find out how to upload a new SVP. 
 
Checking Runtime Parameters  
The final task prior to logging is to check that the Runtime Parameters are valid. Change the Cross Track 
window to a Runtime Parameters window using the drop down menu in the top right corner of the Cross 
Track window.  
 
If running an opportunistic survey set the following:  
 
Navigate to the Sounder Main tab. Set the Max Angle to 55° port and 55° starboard and the Max Width to 
20000m port and 20000m starboard. Set Angular Coverage mode to MANUAL and Beam Spacing to HIDENS 
EQDIST (High Density Equidistant). Set the Min. Depth to 10m and the Max. Depth to 10000m. Set Dual 
swath mode to DYNAMIC and Ping Mode to AUTO and make sure the FM disable box is checked. Tick the 
box for Pitch stabilisation, set Auto tilt to OFF and the Along Direction (deg) to 0. Set Yaw Stabilisation 
Mode to OFF, Heading Filter to MEDIUM and tick the External Trigger box. 
 
Select the Filter and Gains tab. Set Spike Filter Strength to MEDIUM, Range Gate to NORMAL, Phase Ramp 
to NORMAL and Penetration Filter Strength to OFF. Tick boxes for Slope and Sector Tracking but not for 
Aeration and Interference. Set the Angle from nadir to 6°. Set the Absorption Coefficient Source to Salinity 
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and Salinity to 35 ppt (the default). Turn the Mammal protection TX power level to Max and the Soft 
startup ramp time to 0 mins.  
 
You do not need to change anything in any of the other Runtime Parameters tabs. 
 
To Start Logging 
 
Once you are happy with the New Survey setup and the Runtime Parameters you can start logging by 
clicking the red ‘Not Logging’ button on the main toolbar. The button should turn green and say ‘Logging’. 
 
To Stop Logging and Pinging 
 
To stop logging press the green ‘Logging’ button on the main toolbar. To stop logging and pinging 
simultaneously press the green ‘Pinging’ button.  
 
To Turn Off the EM122 
 
Close down SIS and turn off the monitors. Open the glass door of the multibeam computer housing and 
turn off the HWS 14 machine and the EM122 (button behind flap – red light should go off when the system 
is off). 
 
Passing Through Economic Zones 
 
Unless permission has been gained from the relevant authorities the EM122 must not be running in 
economic zones. You need to stop logging and stop pinging. 
 
Watchkeeping 
 
There are several things which should be checked regularly whilst the multibeam is logging. On a supported 
cruise these should be checked at least hourly and if the multibeam is being used opportunistically they 
should be checked twice a day.  
 
Line Incrementation: The line counter should increment automatically every hour so that the raw data files 
do not become too large. If this does not happen automatically then it can be done by pressing the ‘Line 
cnt.’ button.  
 
Note: The box to the right of the ‘Line cnt.’ button shows the line you are logging to if logging is on and the 
line you will start logging to if logging is off. If you stop logging for any reason and would like to start 
logging again to the same line then keep a note of the line number before you stop and then enter the 
number manually into the box before you start again.  
 
Depth Range: Check that the current depth is not getting too close to either the min or max depth values 
set in the Runtime Parameters. If it is then you can change these parameters without stopping the logging 
by using either the Runtime Parameters > Sounder Main tab or the Runtime Parameters Mini window. If 
the multibeam is having trouble finding the bottom then you can force the depth by using a value from the 
EA600. In the Runtime Parameters > Sounder Main tab or the Runtime Parameters Mini window enter a 
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value in the Force Depth box which is just shallower than the actual depth (i.e. if the EA600 reads 1025m 
then put a depth of 1020m in) then press the ‘Force Depth’ button and the multibeam should find the 
bottom again. 
 
Disk Space: Check the remaining disk space on drive D (the raw data drive). 
 
Updating the SVP 
 
The preferred method of importing Sippican XBT and Seabird CTD sound velocities as collected on the 
majority of JCR scientific cruises is described below.  
 
Sippican XBTs 
 
Sippican T-5 (deep) and T-7 (shallow) XBTs can be deployed whilst the vessel is moving, preferably at 6 
knots to ensure a full depth profile. Launch instructions are located near the XBT acquisition machine. The 
results of the XBT are transferred over the network and a couple of minutes after successful deployment 
they can be imported into SIS.  
 
From the main toolbar select Tools > Custom > SVP Editor. Use File > Open and navigate to the U drive 
(named as em122) > asvp directory >cruise/<survey id> and select the latest XBT profile gathered. When 
loaded the profile can be edited to remove bad points, especially those points at the bottom of the profile 
where the XBT has hit the seabed before finishing recording. The profile screen can be zoomed by changing 
values in the from/to depth and sound speed boxes and hitting redraw. Multiple rows can be selected by 
using shift-click on the spreadsheet view before hitting delete row to remove them. When the profile is 
clean it needs to be extended to 12,000m using Tools > Extend Profile in order to satisfy SIS requirement. 
Using Tools > Check profile automatic will identify any problems points that have been missed. Use Tools > 
Thin Profile to reduce the number of points within the profile. Accept the 0.1 thinning ratio and the 
software will automatically reduce the number of points by 90 percent, leaving the most in areas of fastest 
sound velocity change within the profile. Note the EM122 can handle profiles with up to 1000 points in. A 
new file will be created in the current directory called <original_name>_thinned.asvp. This file will be 
automatically transferred to the EM122 machine under D:\sisdata\common\svp_abscoeff\<leg id>. The 
transfer is based on a cron job running every minute so there will be a brief delay before being able to 
select the profile. Close the SVP editor.  
 
Change the Cross Track window to a Runtime Parameters window and choose the Sound Speed tab. Select 
the correct thinned profile from D:\sisdata\common\svp_abscoeff\<leg id>. Click ‘Use sound speed profile’ 
to apply the profile to the current survey line even while still logging.  
 
Seabird CTDs 
 
Following the processing steps on the CTD computer a batch file is run generating an .asvp file that is 
written to the /data/asvp directory. This can be selected in the same way as XBT data following the steps 
already mentioned. 
 
XBT/CTD sound velocity profiles for archival cruises will be added later in 2011 and can be selected in 
exactly the same way. 
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What if the Data Looks Suspect? 
 
Some reasons for occasional glitches in the data include: 

• The multibeam losing the bottom. This can be fixed by forcing the depth. In the Runtime 
Parameters > Sounder Main tab or the Runtime Parameters Mini window enter a value in the Force 
Depth box which is just shallower than the actual depth (i.e. if the EA600 reads 1025m then put a 
depth of 1020m in) then press the ‘Force Depth’ button and the multibeam should find the bottom 
again. 

• The SVP is incorrect for the current conditions. If you notice a smile or a frown in the Across track 
view then it is time to change the SVP.  

• The data being collected become patchy (seen in the Waterfall, Cross track and Geographical 
windows). There are two main things to check. First the bottom depth may have gone outside the 
min and max values in the Runtime Parameters as discussed above. This often results in the centre 
beams dropping out first. The second reason could be that the ping mode is wrong. The mode 
should usually be set to Auto and hence the system should change from deep to shallow etc as 
necessary. If however it does not change for some reason then it can be done manually. To check 
which mode the system is in look at the grey bar along the very bottom of the SIS screen. The 
mode should be displayed as either: SHALLOW (up to 450m), MEDIUM (450-1000m), DEEP (1000-
9000m) or VERY DEEP (over 9000m). If this mode does not relate to the depth you are currently 
surveying then go to Runtime Parameters > Sounder Main and change the drop down menu for 
Ping Mode to the correct setting. Do not forget to change the setting back to AUTO after the 
multibeam has gone back to functioning normally. 

 
Waterfall window – Used to check the quality of 
the data as it is being recorded.

Cross track window – Detailed view of the last few 
pings (blue = amplitude detection, red = phase 
detection) with current  centre beam depth.

Numerical 
display 
window –
Values of 
useful 
metrics 
updated in 
real time.

Main toolbar.

Runtime 
parameters 
mini window –
Useful for 
changing key 
parameters 
whilst logging.

Summary of 
ping mode, 
current depth, 
across track 
width and 
sound speed.

Geographical 
view - Shows 
position of the 
ship and real 
time depths.

Beam intensity 
and Water 
Column 
windows -
Useful for 
assessing the 
quality of the 
beam forming 
and transfer of 
energy through 
the water.

JCR_opportunistic  Set Up in SIS 
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Appendix D – Event logs (EM122 and XBT) 
 
EM122 log 

Date/Time Latitude - 
Seatex 

Longitude - 
Seatex 

Depth - 
EA600 

Wind 
Speed 

Heading - 
Seatex 

Comment 

30/06/2011 
08:04 

50.40106 -10.41839 33.56 15.3 285.99 JRtri006_xbt1_thinned.asvp created and applied. Not logging. 

30/06/2011 
09:25 

50.47513 -10.81691 217.59 14.3 285.65 Start logging to JRtri006_a survey. Testing swath modes over variety of water 
depths (down slope). 

30/06/2011 
09:59 

50.49748 -10.92656 430 11.2 287.27 Started survey with -20dB mammal protection setting. Changed to MAX at 
09:59GMT. This will effect backscatter.  

30/06/2011 
10:13 

50.50676 -10.97428 477.3 10 286.35 beams to 70/70 

30/06/2011 
11:02 

50.53522 -11.13725 730 14.4 284.32 JRtri006_xbt3_thinned.asvp loaded onto swath. Logging to line 2, survey 
JRtri006_a 

30/06/2011 
11:38 

50.55113 -11.25749 605 13.8 282.07 incremented to new line 003 - Deep mode. Check depth from EM122 centreline. 

30/06/2011 
11:44 

50.55377 -11.27801 1048.02 12.5 281.52 beams changed to 68/68 

30/06/2011 
12:26 

50.57694 -11.41585 1629.33 15.6 286.83 Incremented to line 0004: turned off dual ping (still in deep mode). 

30/06/2011 
13:34 

50.61643 -11.63594 1977.53 14 284.4 XBT4 Sv profile uploaded IN LINE 5 FILE 

30/06/2011 
13:38 

50.61883 -11.65101   13.3 284.78 Trying to switch EM122 from single to dual beam mode. Software won't allow 
any changes to parameters. SIS restarted but cause of software glitch not 
identified. 

30/06/2011 
13:42 

50.62096 -11.66417 1870.09 11.4 285.23 Restarted SIS. Pinging and logging to line 0006, survey JRtri006_a. Ping mode 
deep, dynamic for dual ping and 70/70 beams 

30/06/2011 
14:32 

50.65655 -11.86736   6.9 320.92 Starting Noise tests. Tests performed at 0, 1,2,4,6,8,10,12,14 knots 

30/06/2011 
14:32 

50.64936 -11.83524 2043.96 9.4 289.22 test1: killed engines and sounders, prop disengaged 

http://eventlog.jcr.nerc-bas.ac.uk/eventlog/analyst/modify_rec/277/7�
http://eventlog.jcr.nerc-bas.ac.uk/eventlog/analyst/modify_rec/277/7�
http://eventlog.jcr.nerc-bas.ac.uk/eventlog/analyst/modify_rec/277/9�
http://eventlog.jcr.nerc-bas.ac.uk/eventlog/analyst/modify_rec/277/9�
http://eventlog.jcr.nerc-bas.ac.uk/eventlog/analyst/modify_rec/277/13�
http://eventlog.jcr.nerc-bas.ac.uk/eventlog/analyst/modify_rec/277/13�
http://eventlog.jcr.nerc-bas.ac.uk/eventlog/analyst/modify_rec/277/11�
http://eventlog.jcr.nerc-bas.ac.uk/eventlog/analyst/modify_rec/277/11�
http://eventlog.jcr.nerc-bas.ac.uk/eventlog/analyst/modify_rec/277/64�
http://eventlog.jcr.nerc-bas.ac.uk/eventlog/analyst/modify_rec/277/64�
http://eventlog.jcr.nerc-bas.ac.uk/eventlog/analyst/modify_rec/277/15�
http://eventlog.jcr.nerc-bas.ac.uk/eventlog/analyst/modify_rec/277/15�
http://eventlog.jcr.nerc-bas.ac.uk/eventlog/analyst/modify_rec/277/66�
http://eventlog.jcr.nerc-bas.ac.uk/eventlog/analyst/modify_rec/277/66�
http://eventlog.jcr.nerc-bas.ac.uk/eventlog/analyst/modify_rec/277/23�
http://eventlog.jcr.nerc-bas.ac.uk/eventlog/analyst/modify_rec/277/23�
http://eventlog.jcr.nerc-bas.ac.uk/eventlog/analyst/modify_rec/277/21�
http://eventlog.jcr.nerc-bas.ac.uk/eventlog/analyst/modify_rec/277/21�
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Date/Time Latitude - 
Seatex 

Longitude - 
Seatex 

Depth - 
EA600 

Wind 
Speed 

Heading - 
Seatex 

Comment 

30/06/2011 
14:59 

50.65655 -11.86736 0 6.9 320.92 test2: 1 knot with prop 

30/06/2011 
16:16 

50.70531 -12.07707   18 288.31 Finished noise tests at different speeds 

30/06/2011 
16:33 

50.72266 -12.15809   16 285.39 Noise tests with doppler on at 10 knots 

30/06/2011 
16:39 

50.728 -12.18649   14.7 285.44 Doppler logger off 

30/06/2011 
16:43 

50.73089 -12.20186   15.7 284.96 Noise test with ADCP on at 10 knots 

30/06/2011 
16:48 

50.73496 -12.22353   16 285.37 ADCP off 

30/06/2011 
16:55 

50.74095 -12.25552   17.6 285.16 Noise tests with EK60 on at 10 knots 

30/06/2011 
17:02 

50.74631 -12.28485   15.6 285.73 EK60 off. Speed then at 8 knots to repeat noise tests with only prop on 

30/06/2011 
17:13 

50.75377 -12.32509   13.6 284.89 Noise test finished 

30/06/2011 
18:15 

50.87137 -12.35161 2066.86 8.6 6.67 New survey started, Noise_Tests_300611.  Slowing to 4 kts to ping and log at 4, 
6, 8, 10 kts (15 minutes at each speed).  

30/06/2011 
18:20 

50.87908 -12.35029 2067 6.8 4.48 Started logging to Noise_Tests_300611 (4 kts). 

30/06/2011 
18:34 

50.89324 -12.34726 2053 7.7 7.6 Stopped logging. Increasing speed to 6kts. 

30/06/2011 
18:40 

50.90164 -12.34549 2044 8.3 6.46 Started logging (6 kts).  

30/06/2011 
18:54 

50.92466 -12.34089 2022 7.6 6.15 Stopped logging. Increasing speed to 8 kts. 

30/06/2011 
18:58 

50.93293 -12.33941 2016 9.2 6.14 Started logging (8 kts). 

30/06/2011 
19:13 

50.9661 -12.33382 1983 7.9 5.54 Stopped logging. Increasing speed to 10 kts. 
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Date/Time Latitude - 
Seatex 

Longitude - 
Seatex 

Depth - 
EA600 

Wind 
Speed 

Heading - 
Seatex 

Comment 

30/06/2011 
19:19 

50.98249 -12.33099 1966 7.2 5.84 Started logging (10 kts). 

30/06/2011 
19:30 

51.01785 -12.32505 1913 8.8 6.11 Stopped logging. Increasing to 12 kts. 

30/06/2011 
19:38 

51.03553 -12.32173 1892 8.5 6.08 Started logging (12 kts). 

30/06/2011 
19:47 

51.06567 -12.31666 1855 7.6 4.24 Stopped logging. 

30/06/2011 
19:48 

51.06871 -12.31622 1846.95 8.8 4.05 Started logging; line 0005. Beams to 60/60. 

30/06/2011 
20:04 

51.12057 -12.30877 1798 8.9 4.52 Stopped logging.  Doppler logger on bridge turned on. 

30/06/2011 
20:07 

51.13056 -12.30723 1777 7.9 4.03 New survey started: JRtri006_b.  SSU synchronisation testing.  Not logging, not 
pinging. 

30/06/2011 
20:10 

51.14172 -12.30547 1778 7.3 3.72 EM122 pinging, external trigger. 

30/06/2011 
20:25 

51.18986 -12.29833     3.92 SSU synchronisation end - EM122 does not interface with SSU in same way as 
EA600 (where it ignores triggers if not ready) 

30/06/2011 
20:26 

51.19375 -12.29775   9.4 3.75 Start logging to JR_tri006_b. min max beams 65 and 65, min max swath width 
20000. Depth range 50 to 2400 

30/06/2011 
20:33 

51.21553 -12.29446 1718.07 8.2 3.74 SSU crashing. EM122 stopped/started pinging. Eventually logging to line 1. 

01/07/2011 
06:00 

53.18232 -12.04223   3.8 5.39 Overnight data collection OK until shallow depths. Ping mode inadvertently left 
on 'Deep' so very poor data from around 0400. Mode set to Auto and system 
happy once more. 

01/07/2011 
08:56 

53.82727 -11.96017 338.15 3.8 2.88 SIS menu crashing 

01/07/2011 
12:37 

54.55385 -11.86947   3.1 4.14 Switched to autologin as operator, and rebooted machine to check this & U: 
drive mapping works 

01/07/2011 
12:49 

54.59721 -11.86303   3.7 4.28 Stopped pinging to view TOPAS output options 
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Date/Time Latitude - 
Seatex 

Longitude - 
Seatex 

Depth - 
EA600 

Wind 
Speed 

Heading - 
Seatex 

Comment 

01/07/2011 
13:53 

54.80663 -11.83519   7.9 3.8 stopped pinging to take photographs of SSU setup 

01/07/2011 
13:56 

54.81962 -11.8336   8.6 4.24 Stopped pinging to re-interface with SSU 

01/07/2011 
13:57 

54.8208 -11.83347     4.15 Start pinging again logging to line 24 

01/07/2011 
19:37 

54.47949 -11.88129 2865.96 24.1 198.44 T5_00007.asvp entered into system and roll calibration line 1 started logging to 
survey JRtr006_C. Water column data also logged to separate file. 

01/07/2011 
20:18 

55.78257 -11.7232   29.4 201.7 Stopped logging to Line 0001 of the roll bias calibration JRtri006_C. 

01/07/2011 
20:31 

55.78284 -11.72349 2764.75 17.6 21.05 Start of roll calibration line 2. Logging to line 2, survey JRtr006_C 

01/07/2011 
20:56 

55.83146 -11.70519   12 0.66 End roll calibration line 2. Stopped logging 

01/07/2011 
21:34 

55.90175 -11.57596 2725 21 48.55 Finished roll calibration exercise, applied correction of +0.15. 

01/07/2011 
21:38 

55.9087 -11.56114 2703.22 22.8 48.81 Water column data now being saved in raw.all file. Started pinging, started 
logging.  Line 0003 in JRtr006_C survey. 

01/07/2011 
23:40 

56.12366 -11.10434 2546.18 20.7 46.06 Water column logging stopped. Changed setting to store water column date in 
separate file for future collection. Logging to line 5. 

02/07/2011 
02:02 

56.3363 -10.59358   18.6 42.22 Start pitch calibration line 1 heading northeast upslope. Logging to line 0008, 
survey JRtr006_C. Speed 6 knots over ground. Beams at 60/60 degrees 

02/07/2011 
02:36 

56.38342 -10.5351 1242.54 22.7 41.95 End pitch calibration line 1 at top of seamount slope. Stopped logging on line 
0008, survey JRtr006_C. 

02/07/2011 
03:01 

56.38335 -10.536   25.7 209.98 Start pitch calibration line 2 heading downslope. Logging to line 0009, survey 
JRtr006_C. Speed 6 knots. 

02/07/2011 
03:35 

56.33739 -10.59254 2217 22.7 207.37 Stopped logging, end of line 0009. Turning to parallel line. 

02/07/2011 
03:40 

56.33083 -10.60178   24.1 254.72 Pitch calibration completed, no correction (0.0). 
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Date/Time Latitude - 
Seatex 

Longitude - 
Seatex 

Depth - 
EA600 

Wind 
Speed 

Heading - 
Seatex 

Comment 

02/07/2011 
03:53 

56.34776 -10.62569 2267 18.2 40.21 Started logging.  Heading calibration test; logging to line 0010, survey JRtr006_C.  
Speed 6 kts. 

02/07/2011 
04:29 

56.39735 -10.56401 1261 17.7 42.53 End of line, stopped logging. Transit to next parallel line. 

02/07/2011 
05:16 

56.33015 -10.56245 2166 19.4 37.44 Started logging third line for pitch calibration test; line 0011.  Speed 6 kts. 

02/07/2011 
05:47 

56.18921 -10.11357 1977.9 27.3 160.63 Stopped logging line for heading calibration.  Transit to grid survey site. Heading 
correction applied -0.6. 

02/07/2011 
07:09 

56.25855 -10.16306 0 25.7 123.26 Set Up New Survey "JRtri006_D" to be used for the Grid survey. 

02/07/2011 
07:20 

56.25068 -10.13457 1989.44 24.4 124.61 New XBT profile T5_008 input 

02/07/2011 
07:33 

56.25758 -10.15934 0 20.3 279.46 EM122 dual mode changed from fixed to dynamic 

02/07/2011 
07:45 

56.25962 -10.16578 2006.52 27.1 137.81 Start first grid line -EM122 line 000 

02/07/2011 
08:28 

56.18921 -10.11357 1977.9 27.3 160.63 End of first grid line 

02/07/2011 
08:59 

56.17648 -10.19387 2235.82 13 338.85 Second Grid Line, Swath line 0001, started logging. 

02/07/2011 
09:37 

56.24191 -10.23871   16.1 334.07 End logging of second grid line, (0001) 

02/07/2011 
10:02 

56.22539 -10.30999   29 160.32 Start Logging grid line 3, (0002) 

02/07/2011 
10:39 

56.15989 -10.26356 2070.63 28.1 161.98 Stopped logging. End of grid line 3. Line no. 002 (survey JRtri006_D) 

02/07/2011 
11:01 

56.18221 -10.29702 2083.23 21.8 45.36 Start of gridline 4 logged to line_0003 in the swath survey 

02/07/2011 
12:07 

56.2341 -10.11042 1977.72 25.2 73.08 Stopped logging end of grid line 4 

02/07/2011 
12:23 

56.23377 -10.11219 1981.41 24.3 232.28 Start of gridline 5 - roll calibration Swath line 0005 
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Date/Time Latitude - 
Seatex 

Longitude - 
Seatex 

Depth - 
EA600 

Wind 
Speed 

Heading - 
Seatex 

Comment 

02/07/2011 
12:34 

56.22704 -10.13722 1993 23.1 235.99 Stopped logging - too much crabbing on the ship for good swath - re-running 
gridline 1 heading north for roll cal 

02/07/2011 
12:38 

56.23043 -10.14481 1997.94 13.7 340.73 Start logging gridline 6 for roll cal repeat of gridline 1 - swath line 006 

02/07/2011 
12:48 

56.2471 -10.1559 1998.39 11.1 334.91 End of roll cal and end of logging 

02/07/2011 
12:54 

56.25828 -10.1594 3121.17 25.4 110 Adding 0.02 to roll calibration 

02/07/2011 
13:50 

56.22424 -9.89633 3121.17 27 90.76 Commence logging swath to line 0007, survey JRtri006_D 

02/07/2011 
13:52 

56.22458 -9.88195   22.7 91.93 Waterline value added to installation parameters. Given as 0.755m. Calculated 
from ship draught values and new survey values linking frame 76 and Seatex 
MRU. 

02/07/2011 
16:25 

56.10018 -9.15678 1043.67 19.5 118.21 Stop logging as at continental shelf. Last line logged was 0010, survey JRtri006_D 

03/07/2011 
14:00 

55.87113 -4.35358 0 4.9 173.48 Arrive at Glasgow 

 
XBT log 

Date/Time Latitude - Seatex Longitude - Seatex Depth - EA600 Comment 

30/06/2011 07:46 50.38921 -10.3413 142.86 JRtri006_xbt1; T5 probe launched successfully. 

30/06/2011 10:39 50.52301 -11.06 567.91 JRtri006_xbt2 launched but no data received in UIC. Failed XBT. 

30/06/2011 10:43 50.52583 -11.0759 613.92 JRtri006_xbt3; T5 probe launched successfully 

30/06/2011 13:09 50.60563 -11.5665 1914 Slowing to 6kts to launch XBT in full range of water depth. 

30/06/2011 13:15 50.60787 -11.5811 1925.92 XBT T5_0004 deployed 

30/06/2011 13:24 50.61144 -11.6042 1950.76 Increasing speed to 8 knots again 

01/07/2011 12:15 54.47949 -11.8813 2865.96 JRtri006_xbt5.asvp applied to survey 

02/07/2011 07:11 56.25758 -10.1593 2012 XBT T5_008 deployed prior to calibration grid 
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Appendix E – Kongsberg transducer report (received September 2011) 
 
 
EM 120 transducers on James Clark Ross  
Report made by KM: September 2011  

RX array  
1 degree RX array, 128 hydrophones, module serial numbers: 123, 124, 125, 126, 127, 128, 129, 130, 
131, 132, 133, 134, 135, 136, 137, and 138  

The impedance of the RX transducer staves has been measured on board the ship. We use these 
measurements to simulate the beam pattern of the receiver array. Looking at the conductance G of each 
hydrophone (presented in Figure 1) we note a worrying trend: There are eight hydrophones per module and 
many of the edge elements 1, 8, 9, 16, 17, 24, 25,…..120, 121, and 128 can be seen to have an increased G. 
Based on (limited) empirical knowledge about the relationship between EM 120 hydrophone conductivity G 
and receive sensitivity, we apply reduced sensitivity to all elements whose G is above 0.5 mS. Also, for every 
element we assume the phase of an incident sound wave is affected by the phase of the impedance. The 
resulting element shading is illustrated in Figure 2.  

 

Figure 1: Conductance G for all 128 EM 120 hydrophones measured at 12 kHz.  
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Figure 2: Array shading. Top: Magnitude of estimated element weights (desired weighting scaled to account for 
reduced element sensitivity and distorted element phase). Bottom: Phase of estimated element weights.  
 
 

 
Figure 3: The ideal across beam pattern (blue) and the estimated beam pattern (green) for the EM 120 Rx aray 
installed on James Clark Ross. The most noticeable difference is an increase in maximum side lobe level of about  
2.5 dB. The main lobe is reduced by < 0.2 dB.  

The simulated beampattern (across) is shown in Figure 3 along with the ideal beam pattern. It is found that 
the sensitivity in the main lobe is reduced by less than 0.2 dB and the side lobe levels are increased by less 
than 2.5 dB compared to the ideal case.  

The reduction of the main lobe is very small and in practice it is not likely to give a noticeable degradation of 
the data quality. The increased side lobe levels may in special situations under good survey conditions cause 
a minor decrease of data quality. In general we find a side lobe suppression of 25 dB to be within acceptable 
limits and judged only from these criteria (main lobe / side lobes) there is no need to correct this array. 

 



[74] 

 

However, see the discussion below.  

 
1 deg. Transmitter array  
The 864 TX transducer elements have been measured by an impedance analyzer. Module serial numbers are 
931, 952, 953, 956, 958, 963, 964, 965, 966, 968, 969, 970, 972, 973, 974, 975, 976, 977, 978, 979, 980, 981, 
982, 983, 984, 985, 986, 992, 994, 995, 996, 997, 998, 999, 1005, 1006, 1016, 1017, 1023, 1024, 1025, 1026, 
1028, 1029, 1030, 1032, 1033, and 1035.  

It is found that 137 elements are out of specifications. These elements transmit a reduced amount of 
power and cause a significant reduction of the system source level. This reduction is frequency 
dependent (maximum reduction at the lowest frequencies, minimum reduction around 12 kHz). Also, the 
peak side lobe level increases.  
 
To assess the effect of the bad TX elements we simulate the transmit beam patterns. Since the EM 120 
has sectorized transmission with different signal frequencies and in general also different array shading in 
the various sectors we calculate the beam patterns for all sectors to determine the damaged elements 
impact on the beam pattern. Also, the use of frequencies and array shading varies with depth so we do 
these calculations for operating modes deep and very deep.  
In mode “deep” we find that the reduction in source level varies from 1.3 dB up to 1.8 dB. The combined 
effect of source level reduction and increased side lobe level is that the main lobe to side lobe margin (side 
lobe suppression – SLS) is reduced by 2.2 to 6.5 dB. A sample beam pattern from deep mode is shown in 
Figure 4.  

In mode “very deep” we find that the reduction in source level varies from 1.3 dB up to 1.4 dB. The SLS is 
reduced by 4.5 to 6 dB. A sample beam pattern from very deep mode is shown in Figure 5.  
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Figure 4: Beam pattern across (top) and along (bottom) for sector 3 of the EM 120 in deep mode. The blue curves 
show the ideal beampatterns. The green curves show the estimated beam patterns of the degraded TX array. The 
obvious disagreement in peak level is caused by the beam pattern “along” being calculated without roll: The rolled 
sector (top) is somewhat attenuated due to the directivity of the transmit elements.  
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Figure 5: Beam pattern across (top) and along (bottom) for sector 7 of the EM 120 in very deep mode. The blue curves 
show the ideal beampatterns. The green curves show the estimated beam patterns of the degraded TX array.  
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Discussion  
The total performance of the system may under otherwise excellent conditions be somewhat reduced by the 
errors observed on the receiver array. The most alarming regarding the RX array is that we see a tendency to 
increased conductance at the RX modules edge elements. This may indicate that the Rx array is under 
deterioration. We have little experience with how this kind of damage develops over time. We recommend 
monitoring this array closely. A complete set of impedance measurements should be carried out every 6 to 
12 months. Also operators should look for any sign of staves with reduced sensitivity, e.g. BIST noise test.  

The transmitter is affected by the large extent of damaged transducers. On the transmit side we are not so 
troubled by increased side lobes: For most practical situations it is the reduction of the source level that 
limits the performance of the system. We found that the source level reduction is less than 2 dB for all 
frequencies/sectors in both “deep” and “very deep” mode. To get an idea of the performance of this 
degraded system we include in Figure 6 an illustration showing the estimated performance of an ideal 1° x 1° 
EM 122 system together with the performance of an identical system with source level reduced by 2 dB.  
We see there is no loss of coverage in shallow water (< ~2500 m water depth). With increasing depth the 
loss of performance is evident. As an example: With a sandy bottom at water depth 6000 m the coverage 
is reduced from 26/6 times the water depth to 25/6 times the water depth when the source level is 
reduced by 2 dB –a reduction of coverage around 4 %

 

. In addition to this reduced coverage it may be 
possible to find examples of reduced data quality due to the degraded RX array.  

 

 
Figure 6: Estimated coverage with three kinds of seabed for an ideal system and a system with 2 dB reduced source 
level. 
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JRtri006 Scientific Party (from left): Jeremy Robst, Christine Bachelor, Luke Collins, Kelly Hogan,  Gwen 
Newton, Sophie Fielding, Johnnie Edmonston, Alex Tate, Alastair Graham, Craig Wallace.  
 
Photo taken by Richard Turner. 
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